




Preface
Notice
The company reserves the right to revise this publication or to change its contents without notice. Infor-
mation contained herein is for reference only and does not constitute a commitment on the part of the man-
ufacturer or any subsequent vendor. They assume no responsibility or liability for any errors or
inaccuracies that may appear in this publication nor are they in anyway responsible for any loss or damage
resulting from the use (or misuse) of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated,
transmitted or reduced to any machine readable form without prior consent from the vendor, manufacturer
or creators of this publication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered
trademarks of their respective companies. They are mentioned for identification purposes only and are not
intended as an endorsement of that product or its manufacturer.

© March 2004

Trademarks
This product incorporates copyright protection technology that is protected by method claims of certain
U.S. patents and other intellectual property rights owned by Macrovision Corporation and other rights
owners. Use of this copyright protection technology must be authorized by Macrovision Corporation, and
is intended for home or other limited viewing uses only unless otherwise authorized by Macrovision Cor-
poration. Reverse engineering or disassembly is prohibited.
Intel and Pentium are registered trademarks of Intel Corporation.
I



II

Preface
FCC Statement
(Federal Communications Commission)
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or television reception, which can
be determined by turning the equipment off and on, the user is encouraged to try to correct the interference
by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the service representative or an experienced radio/TV technician for help.

Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifica-
tions not expressly approved by the manufacturer for compliance with the above standards could void your au-
thority to operate the equipment.
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IMPORTANT SAFETY INSTRUCTIONS
When using your telephone equipment, basic safety precautions should always be followed to reduce the
risk of fire, electric shock and injury to persons, including the following:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, 
in a wet basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. 
There may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They 

may explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit.

CAUTION
Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equip-
ment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, 
TELECOMMUNICATION LINE CORD
III
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Preface
Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be 
damaged.

2. Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of 
heating element. This is an electrical appliance. If water or any other liquid gets into it, the computer 
could be badly damaged.

Do not expose the computer 
to any shock or vibration.

Do not place it on an unstable 
surface.

Do not place anything heavy 
on the computer.

Do not expose it to excessive 
heat or direct sunlight.

Do not leave it in a place 
where foreign matter or mois-
ture may affect the system.

Don’t use or store the com-
puter in a humid environment.

Do not place the computer on 
any surface which will block 
the vents.
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3. Avoid interference. Keep the computer away from high capacity transformers, electric motors, and 
other strong magnetic fields. These can hinder proper performance and damage your data.

4. Follow the proper working procedures for the computer. Shut the computer down properly and 
don’t forget to save your work. Remember to periodically save your data as data may be lost if the 
battery is depleted.

5. Take care when using peripheral devices.

Do not turn off the power 
until you properly shut down 
all programs.

Do not turn off any peripheral 
devices when the computer is 
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance 
on your computer.

Use only approved brands of 
peripherals.

Unplug the power cord before 
attaching peripheral devices.
V
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Power Safety
The computer has specific power requirements:

• Only use a power adapter approved for use with this computer.
• Your AC adapter may be designed for international travel but it still requires a 

steady, uninterrupted power supply. If you are unsure of your local power specifi-
cations, consult your service representative or local power company.

• The power adapter may have either a 2-prong or a 3-prong grounded plug. The 
third prong is an important safety feature; do not defeat its purpose. If you do not 
have access to a compatible outlet, have a qualified electrician install one.

• When you want to unplug the power cord, be sure to disconnect it by the plug head, 
not by its wire.

• Make sure the socket and any extension cord(s) you use can support the total cur-
rent load of all the connected devices.

• Before cleaning the computer, make sure it is disconnected from any external 
power supplies.

Do not plug in the power 
cord if you are wet.

Do not use the power cord if 
it is broken.

Do not place heavy objects 
on the power cord.

Power Safety 
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines). It is
advisable to also re-
move your battery in
order to prevent acci-
dentally turning the
machine on.
I
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Battery Precautions
• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the com-

puter.
• Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative 

or qualified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. 

Batteries may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.

Battery Disposal
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of
its useful life, under various state and local laws, it may be illegal to dispose of this battery into the municipal
waste stream. Check with your local solid waste officials for details in your area for recycling options or proper
disposal.

Caution
Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommend-
ed by the manufacturer. Discard used battery according to the manufacturer’s instructions.
VII
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Cleaning
Do not apply cleaner directly to the computer, use a soft clean cloth. 
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and
the computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer
from the power supply. Then refer servicing to qualified service personnel under any of the following con-
ditions:

• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.
III
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Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC adapter and cables. Stow them in the carrying bag. 
5. The AC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. 

However, check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those 

devices’ adapters and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership 

for both hardware and software. Make sure your “papers” are handy.

Power Off Before Traveling
Make sure that your computer is completely powered off before putting it into a travel bag (or any such container).
Putting a computer which is powered on in a travel bag may cause the vents/intakes to be blocked. To prevent
your computer from overheating make sure nothing blocks the vent/fan intake while the computer is in use.
IX
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On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshoot-
ing, keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is
very common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful.
Avoid knocking the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the
computer, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your
computer and disks around the devices. Ask security officials to hand-inspect them (you may be asked to
turn it on). Note: Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in
flight. These restrictions are for your safety, follow them. If you stow the notebook in an overhead com-
partment, make sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC adapter and keep your bat-
tery(ies) charged.

Keep it dry - If you move quickly from a cold to a warm location, water vapor can condense inside the
computer. Wait a few minutes before turning it on so that any moisture can evaporate.
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Developing Good Work Habits
Developing good work habits is important if you need to work in front of the computer for long periods
of time. Improper work habits can result in discomfort or serious injury from repetitive strain to your
hands, wrists or other joints. The following are some tips to reduce the strain:

• Adjust the height of the chair and/or desk so that the keyboard is at or slightly 
below the level of your elbow. Keep your forearms, wrists, and hands in a relaxed 
position.

• Your knees should be slightly higher than your hips. Place your feet flat on the 
floor or on a footrest if necessary.

• Use a chair with a back and adjust it to support your lower back comfortably.
• Sit straight so that your knees, hips and elbows form approximately 90-degree 

angles when you are working.
• Take periodic breaks if you are using the computer for long periods of time.

Remember to:
• Alter your posture frequently.
• Stretch and exercise your body several times a day.
• Take periodic breaks when you work at the computer for long periods of time. Fre-

quent and short breaks are better than fewer and longer breaks.
XI
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your
neck and shoulders.

• Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
• Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen 

clearly.
• Position the display directly in front of you at a comfortable viewing distance.
• Adjust the display viewing angle to find the best position.
II
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1Introduction
Chapter 1: Introduction
Overview
This manual refers to the hardware and essential software required to run your
notebook computer. Depending on how your system is configured, some or all
of the features described may already be set up. This chapter covers:

• The Manual — how to use it
• System Map — navigating around your computer

Advanced Users
If you are an advanced user you may skip over most of this manual. However
you may find it useful to refer to “Drivers & Utilities” on page 4 - 1, “BIOS
Utilities” on page 5 - 1 and “Upgrading The Computer” on page 6 - 1. You
may also find the notes marked with a  of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them)
then you should try to look through all the documentation. Do not worry if you
do not understand everything the first time. Keep this manual nearby and refer
to it to learn as you go. You may find it useful to refer to the notes marked with
a  as indicated in the margin.

Notes

Check the light colored
boxes with the mark
above to find detailed
information about the
computer’s features. 
Overview 1 - 1
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Warning Boxes
No matter what your level please pay careful attention to the warning and safe-
ty information indicated by the  symbol. Also please note the safety and
handling instructions as indicated in the Preface.

Not Included
Operating Systems (e.g. Windows 2000 Professional, Windows XP etc.) have
their own manuals, as do applications (e.g. word processing, spreadsheet and
database programs). If you have questions about the operating systems or pro-
grams then please consult the appropriate manuals.

System Software
Your computer may already come with system software pre-installed. Where
this is not the case, or where you are re-configuring your computer for a dif-
ferent system, you will find this manual refers to the following operating sys-
tems:

• Microsoft Windows 2000
• Microsoft Windows XP
- 2 Overview
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Quick Start Guide
This guide assumes that you are already familiar with computers and can tell
at a glance what and where all the key components are. If you are not that com-
fortable with this type of device, then please refer to the following pages,
which give an overview of the system.

It is still best to review these steps, before taking any action. If there is any-
thing you are not sure about, then please refer to the appropriate chapter before
continuing.

Unless you need to install an operating system, your computer should be ready
to work right out of the box. Before you begin please follow the safety instruc-
tions in the Preface.

1. Remove all packing materials, CDs/DVDs, floppy disks, and any PC Cards.
2. Securely attach any peripherals you want to use with the notebook (e.g. 

keyboard and mouse) to their ports.
3. Attach the AC adapter to the DC-in jack at the rear of the computer (see 

“Rear View” on page 1 - 18), then plug the AC power cord into an outlet, 
and connect the AC power cord to the AC adapter.

4. Raise the lid/LCD to a comfortable viewing angle.
5. Press the power button to turn “on”.

Peripheral Devices

Please note that pe-
ripherals (printers, dig-
ital cameras, etc.)
which attach to your
computer by either
USB or Mini-IEEE
1394 ports may be
connected after Win-
dows is up and run-
ning. All other
peripherals must be
connected before you
turn on the system.
Quick Start Guide 1 - 3
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System Map
Your computer has a lot of built-in features. Most of these are enabled by your
operating system. Further explanations of the various subsystems are covered
in the chapter or pages indicated.

Getting to Know Your Computer
The graphics on the following pages will help you to become familiar with the
basic functions, and to learn the location of the various ports and components
of your computer.
- 4 System Map
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Model Differences
This notebook series includes four different model types according to the
specifications. You can identify your computer by checking Table 1 - 1,
“Model Differences” on page 1 - 5. In addition to the four model types, there
are also two different designs (see Figure 1 - 1) as illustrated on the following
page.

Feature Model A Model B Model C Model D

Designs Supported Design I & II Design I & II Design I & II Design I & II

CPU Supported Desktop Mobile Desktop Desktop & Mobile 
(Portability)

IEEE 1394 Port Yes Yes No Yes

PCMCIA (PC Card) Yes Yes No Yes

Infrared Transceiver Yes Yes No Yes

Floppy Disk Drive Yes Yes No Yes

RAM Options 2 slots for up to 
1024MB RAM

2 slots for up to 
1024MB RAM

1 slot for up tp 
512MB RAM

2 slots for up to 
1024MB RAM

AC Adapter 20V, 5A 20V, 3.25A 20V, 5A 20V, 6A

Table 1 - 1
Model Differences
System Map 1 - 5
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Design I Design II

Figure 1 - 1
Design Differences

Design Types

This manual refers to
the two notebook de-
signs pictured on this
page.

The designs vary
slightly in external de-
sign (and apply to all
computer Models).
Photographs used
throughout this manual
are of Design I.
- 6 System Map



1Introduction
Top View

To open the LCD display:

1. Place the computer on a stable surface.
2. Move the LCD latches  in the direction of the arrows to release the top 

cover.
3. Lift the top cover to reveal the LCD panel and keyboard.
4. Adjust the LCD panel to a comfortable viewing angle.
5. The LED indicators  show the power and battery status of the computer, 

give notification of e-mail received, and the power status of wireless 
modules.

1

2

1

Figure 1 - 2
Top View with LCD 

Panel Closed

1. LCD Latches
2. LED Power & 

Communication 
Indicators

1

2

Top View 1 - 7
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Top View with LCD Panel Open

Figure 1 - 3
Top View with LCD 

Panel Open

1. Optional PC 
Camera

2. LCD
3. Built-In Microphone
4. LED Power & 

Communication 
Indicators

5. LED Status 
Indicators

6. Hot-Key buttons
7. Close Cover Switch
8. Power Button
9. Keyboard
10. TouchPad and 

Buttons

2

6

4

5

7

1

8

3

9

10
- 8 Top View
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PC Camera
If you have purchased the optional PC Camera, make sure to install the soft-
ware application (see “PC Camera” on page 7 - 10).

LCD Panel
The computer comes with a 14.1" OR a 15.0" TFT (Liquid Crystal Display)
screen, depending upon the configuration purchased. Check the appropriate
Appendix for details on the LCD options.

Microphone
Record on your notebook computer with the built-in microphone.

LED Power & Communication Indicators
These indicators display the system power status, and battery status of the
computer. The third indicator may be configured to give a visual confirmation
when e-mail is received in the default e-mail program (see “LED Power &
Communication Indicators” on page 2 - 6).

LED Status Indicators
These display the system’s operational status. Refer to “LED Status Indica-
tors” on page 2 - 5 for more information on what the lights mean.
Top View 1 - 9



Introduction

1

1

Hot-Key Buttons
The three hot-keys allow you instant access to your default Internet browser,
default e-mail program, and an application of your choice. To learn how to set
the buttons, see “Hot-Keys” on page 2 - 17.

Close Cover Switch
This switch acts as a sensor to tell when the LCD Panel is closed. When this
LCD cover sensor is activated the default setting of your operating system’s
power scheme sends the computer into a power saving state (see Figure 3 - 18
on page 3 - 25).

Power Button
Press this button to turn your computer on or off (see “Turning on the
Computer” on page 2 - 4). This button may also be used as a suspend/resume
key, once configured as such in the power management control panel of your
operating system (see “Configuring the Power Button” on page 3 - 25).

Shutdown

Please note that you
should always shut
your computer down
by choosing the Shut
Down/Turn Off Com-
puter command from
the Start menu in Win-
dows. This will help
prevent hard disk or
system problems.
- 10 Top View
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Keyboard
The computer has a “Win Key” keyboard including a numeric keypad. It has
the same features as a full-sized desktop keyboard and can easily be replaced
with a different language keyboard should you desire.

TouchPad & Buttons
The pointing device features a sensitive glide pad for precise movements. It
functions the same way as a two-button mouse. The right TouchPad button is
the same as the right mouse button; the left TouchPad button is the same as
the left mouse button. The central button may be used to scroll up and down,
or may be configured to perform a variety of functions (see “Configuring the
TouchPad and Buttons” on page 2 - 21). 

Forced Off

If the system “hangs”,
and the Ctrl + Alt + Del
key combination
doesn’t work, press the
power button for 4 sec-
onds, or longer, to
force the system to
turn itself off.
Top View 1 - 11
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Front ViewFigure 1 - 4

Front View

1. LCD Latches
2. Mini-IEEE 1394 

Port
3. S/PDIF Out Port
4. Microphone-In Jack
5. Headphone-Out 

Jack
6. Infrared 

Transceiver
7. Wireless Module 

ON/OFF Switch
8. Built-In Speakers

Model C computers do
not include either an in-
frared transceiver or a
mini-IEEE 1394 port.

1 1

8 8

IEEE 1394

The Mini-IEEE 1394 port only supports SELF POWERED IEEE 1394 devices.

Infrared Communication

The Infrared transceiver operates on a “Line of Sight”. Make sure nothing is block-
ing the “Line of Sight” between your system’s transceiver and the destination’s
transceiver.

4 5 6 72 3
- 12 Front View
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Mini-IEEE 1394 Port (Models A, B & D only)
This allows high-speed connection to various peripheral devices, e.g. external
disk drives and digital cameras. 

S/PDIF Out Port
This S/PDIF (Sony/Philips Digital Interface Format) Out Port allows you to
connect your DVD-capable PC to a Dolby AC-3 compatible receiver for “5.1”
or ‘dts’ surround sound.

Microphone-In Jack
Record on your notebook computer with an external microphone.

Headphone-Out Jack
Headphones may be connected through this jack. Note: Set your system’s vol-
ume to a reduced level before connecting to this jack.

Infrared Transceiver (Models A, B & D only)
The infrared transceiver enables communication between the computer and
another similarly equipped device, and is 4M bps FIR, IrDA 1.1 compliant.
For further information please refer to the manual of the device you wish to
connect (see “Configuring the Infrared Settings for FIR” on page 3 - 28).
Front View 1 - 13
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Wireless Module ON/OFF Switch
If you have purchased the optional 802.11b Wireless LAN and/or Bluetooth
module(s), you can use this switch to turn the module(s) ON or OFF. To en-
able the module(s) you will need to install the drivers/software for it/them.
You can use the key combination Fn + F12 to toggle through the options if
you have two modules installed (see “Wireless LAN & Bluetooth Modules”
on page 7 - 2 and “LED Power & Communication Indicators” on page 2 -
6).

Stereo Speakers
Two built-in speakers provide rich, stereo sound.

Wireless Device 
Operation Aboard 

Aircraft

The use of any porta-
ble electronic trans-
mission devices
aboard aircraft is usu-
ally prohibited. Make
sure the modules are
OFF if you are using
the computer aboard
aircraft.

 Communication Conflict

Do not try to use the 802.11b Wireless LAN module and the Bluetooth module at
the same time, as this may cause a communication conflict.
- 14 Front View



1Introduction
Left Side View

CD Device Bay
A 5.25" CD-ROM drive, or DVD-ROM drive, or CD-RW, or Combination
CD-RW and DVD-ROM, or DVD-RW Drive (12.7mm height) is standard de-
pending on the model you purchased. For more information on using the drive
please refer to “CD/DVD Device” on page 2 - 12.

3
4

1
52

Figure 1 - 5
Left Side View

1. CD Device Bay
2. USB 2.0 Port
3. Floppy Disk Drive
4. PC Card Slot
5. PC Card Slot Eject 

Button

Model C does not in-
clude either the Floppy
Disk Drive or PC Card.

CD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to an unexpected power interrup-
tion) you may push the end of a straightened paper clip into the emergency eject
hole. Do not use a sharpened pencil or similar object that may break and become
lodged in the hole.
Left Side View 1 - 15
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USB 2.0 Port
This USB 2.0 compatible port (USB 2.0 is fully USB 1.1 compliant) is for
low-speed peripherals such as keyboards, mice or scanners, and for high-
speed peripherals such as external HDDs, digital video cameras or high-speed
scanners etc. Devices can be plugged into the computer, and unplugged from
the computer, without the need to turn the system off (if the power rating of
your USB device is 500mA or above, make sure you use the power supply
which comes with the device).

3.5" FDD (Models A, B & D only)
This is a 3.5", 1.44 MB floppy disk drive (FDD). For more information please
refer to “Floppy Disk Drive (FDD)” on page 2 - 11.

PC Card Slot (Models A, B & D only)
The 3.3V/5V slot may be used for a Type-II PC card (PC cards were also pre-
viously referred to as PCMCIA) and fully supports Cardbus. Refer to “PC
Card Slot” on page 2 - 16 for more information.

Media Warning

Don’t try to remove a
floppy disk while the
system is accessing it.
This may cause the
system to “crash”.
- 16 Left Side View
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Right Side View

Security Lock Slot
To prevent possible theft, a Kensington-type lock can be attached to this slot.
Locks can be purchased at any computer store.

1

Figure 1 - 6
Right Side View

1. Security Lock Slot
Right Side View 1 - 17
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Rear View

Vent
This enables airflow to prevent the notebook from overheating.

DC-In Jack
Plug the supplied AC adapter into this jack to power your notebook.

Figure 1 - 7
Rear View

1. Vent
2. DC-In Jack 
3. 2 * USB Ports
4. External Monitor 

(CRT) Port
5. Parallel Port
6. Serial Port
7. S-Video-Out Port
8. PS/2 Type Port
9. RJ-11 Phone Jack
10. RJ-45 LAN Jack

3
4 5 6 7 8 9 101

2

Overheating

To prevent your com-
puter from overheating
make sure nothing
blocks the vent/fan in-
take while the comput-
er is in use.
- 18 Rear View
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2 * USB 2.0 Ports
These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for
low-speed peripherals such as keyboards, mice or scanners, and for high-
speed peripherals such as external HDDs, digital video cameras or high-speed
scanners etc. Devices can be plugged into the computer, and unplugged from
the computer, without the need to turn the system off (if the power rating of
your USB device is 500mA or above, make sure you use the power supply
which comes with the device).

External Monitor (CRT) Port
Connect an external VGA monitor (CRT) to this port to allow dual video or
simultaneous display on the LCD and external VGA monitor (see “Display
Devices” on page 3 - 8).

Printer/Parallel Port
This port supports ECP (Extended Capabilities Port) and EPP (Enhanced Par-
allel Port).

Serial Port
Connect a serial type mouse to this port.
Rear View 1 - 19
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S-Video Out Port
Connect your television to your computer and view DVDs, VCDs or anything
else your computer can display. You will need an S-Video cable to make the
connection. Enable this port from the video driver controls (see “TV Display”
on page 3 - 19).

PS/2 Type Port
Connect an external PS/2 type mouse or keyboard to this port. You can use a
“Y” splitter if you want to attach both.

RJ-11 Phone Jack
This port connects to the built-in modem. You may plug the telephone line di-
rectly into this RJ-11 telephone connection.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

RJ-45 LAN Jack
This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.
- 20 Rear View
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Bottom View

Vent
This enables airflow to prevent the notebook from overheating.

Battery
See “Battery Information” on page 3 - 26 for instructions on battery use and
care.

Figure 1 - 8
Bottom View

1. Vent/Fan Intake 
2. Battery Cover
3. Hard Disk Cover
4. Bluetooth Module 

Cover
5. CPU & Memory 

Socket Cover

Note: The RAM and option-
al Wireless LAN module are
located under the CPU Heat-
sink Cover.

1
1

2

4

5

3

CPU

The CPU is not a user
serviceable part.
Opening this compart-
ment, or accessing the
CPU in any way, may
violate your warranty.

Overheating

To prevent your com-
puter from overheating
make sure nothing
blocks the vent/fan in-
take while the comput-
er is in use.
Bottom View 1 - 21
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Hard Disk Drive
The internal hard disk drive is used to store your data. See information on page
6 - 4 for information on upgrading/replacing your hard disk drive.

Wireless LAN (Network) Module
If your computer has the optional mini PCI 802.11b Wireless LAN module,
the antenna and other components are not externally visible (please check with
your service representative). If your configuration includes the Wireless LAN
module, make sure to install the driver (see sidebar note).

Bluetooth Module
If your computer has the optional Bluetooth module, the antenna and other
components are not externally visible (please check with your service repre-
sentative). If your configuration includes the Bluetooth module, make sure to
install the software (see sidebar note).

Drive Warning

Don’t try to remove the hard disk (HDD) while the system is on. This could cause
data loss or damage. Unauthorized removal or tampering with the HDD may violate
your warranty. If you are in doubt, consult your service representative.

Wireless LAN & 
Bluetooth Modules

The Wireless LAN and
Bluetooth modules
may be enabled and
disabled by the switch
at the front of the com-
puter (see “Wireless
Module ON/OFF
Switch” on page 1 -
14).

If you have both op-
tional wireless mod-
ules in your computer,
you can use the Fn +
F12 key combination
to toggle power to the
modules (see “Wire-
less LAN & Bluetooth
Modules” on page 7 -
2).
- 22 Bottom View
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Chapter 2: Using The Computer
Overview
To learn more about using your computer, please read this chapter.

This chapter includes:

• The Power Sources
• Turning on the Computer
• The LED Indicators
• The Auto Mail Program
• The Hard Disk Drive
• The Floppy Disk Drive
• The CD/DVD Device
• The PC Card Slot
• The Hot-Keys
• The Function Keys & Numeric Keypad
• The TouchPad & Buttons/Mouse
• Adding a Printer (general guidelines)
Overview 2 - 1
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 The Power Sources
The computer can be powered by either an AC adapter or a battery pack.

AC Adapter
Use only the AC adapter that comes with your computer. The wrong type of
AC adapter will damage the computer and its components. 

1. Attach the AC adapter to the DC-in jack at the rear of the computer.
2. Plug the AC power cord into an outlet, then connect the AC power cord to 

the AC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “on”.

Battery
The battery allows you to use your notebook computer while you are on the
road or an electrical outlet is unavailable. Battery life varies depending on the
applications and the configuration you're using. To increase battery life, let the
battery discharge completely before recharging. 

We recommend that you do not remove the battery. For more information on
the battery, please refer to “Battery Information” on page 3 - 26.

Power Button as 
Standby or Hibernate 

Button

If you are using a fully
ACPI-compliant OS,
(such as Windows
2000 Professional, or
Windows XP) you can
use the OS’s “Power
Options” control panel
to set the power button
to send the system into
Standby or Hibernate
mode (see your OS’s
documentation, or
“Configuring the
Power Button” on
page 3 - 25 for de-
tails).
- 2 The Power Sources
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Recharging the Battery with the AC Adapter
The battery pack automatically recharges when the AC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it
will take several hours to fully recharge the battery. When the computer is
turned off but plugged into an electrical outlet, battery charge time is less. (Re-
fer to “LED Indicators” on page 2 - 5 for information on the battery charge
status, and to “Battery Information” on page 3 - 26 for more information on
how to maintain the battery pack.)

Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other

 Battery Removal

We recommend that
you do not remove the
battery yourself.
Please consult your
service representative
should you need to re-
move the battery for
any reason.

Low Battery Warning

When the battery is
critically low, immedi-
ately connect the AC
adapter to the comput-
er or save your work,
otherwise, the un-
saved data will be lost
when the power is de-
pleted.
The Power Sources 2 - 3
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 Turning on the Computer
Now you are ready to begin using your computer. To turn it on simply press
the power button on the front panel.

When the computer is on, you can use the power button as a Standby/Hiber-
nate/Shutdown hot-key button when it is pressed for less than 4 seconds
(pressing and holding the power button for longer than this will shut the com-
puter down). Use Power Options in the Windows control panel to configure
this feature.

Shutdown

Note that you should
always shut your com-
puter down by choos-
ing the Shut Down/
Turn Off Computer
command from the
Start menu in Win-
dows. This will help
prevent hard disk or
system problems.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press
the power button for 4 seconds, or longer, to force the system to turn itself off.
- 4 Turning on the Computer



Using The Computer

2
LED Indicators
There are two sets of LED indicators (LED Power & Communication Indi-
cators and LED Status Indicators) on your computer that will display help-
ful information about the current status of the computer. The LED Power &
Communication Indicators are also visible when the top of your computer
is closed.

LED Status Indicators
Icon Color Description

Green Floppy/Hard disk/CD Device activity

Green Number Lock is activated

Green Caps Lock is activated

Green Scroll Lock is activated (to activate press Fn & ScrLk)

Figure 2 - 1
LED Indicators

Scroll Lock

To enable and disable
the Scroll Lock feature,
press the Fn and
ScrLk keys simultane-
ously.

Table 2 - 1
LED Status 
Indicators

Power & Communication Indicators LED Status Indicators
LED Indicators 2 - 5
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 LED Power & Communication Indicators
Icon Color Description

Orange AC Adapter is plugged in

Green The computer is on

Blinking Green The computer is in standby mode 

Orange The battery is being charged

Green The battery is fully charged

Blinking Orange The battery has reached critically low power status

Blinking Half 
Orange/ Half 

Green
 The battery has a serious problem (see sidebar)

Blinking Green New mail has arrived

Fast Blinking 
Green

New mail has arrived from users defined in the Special 
Group in Auto Mail Checker

Green The (optional) Wireless LAN module is On

Orange The (optional) Bluetooth module is On

Half Orange/Half 
Green

Both the (optional) Wireless LAN and Bluetooth 
modules are On (see sidebar)

 Battery Problem

If the battery has a se-
rious problem contact
your service represen-
tative.

 Communication 
Conflict

Do not try to use the
802.11b Wireless LAN
module and the Blue-
tooth module at the
same time, as this may
cause a communica-
tion conflict.

Table 2 - 2
LED Power & 

Communication 
Indicators
- 6 LED Indicators
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Auto Mail Checker
After you have installed the driver for the Auto Mail program (see “What to
Install” on page 4 - 1) you may then configure it to give you notification when
you receive new mail. You must be online to receive this notification (note
that this program only supports the POP3 protocol), and your default mail
program does not need to be open.

The Auto Mail Checker appears as an icon  in the taskbar. Clicking on the
icon will bring up the following options menu. (If you have not input your
mail account data, then you will be prompted to do so.)

Select Open to bring up the control panel for the program.

Figure 2 - 2
Auto Mail Checker 

(Startup Menu)
Auto Mail Checker 2 - 7
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You may then configure the options for your mailserver, name, password, pro-
gram and method(s) of notification.

Note

Check with your Inter-
net Service Provider,
network administrator
or Mail Service provid-
er for details on what to
put on these pages.

Figure 2 - 3
Auto Mail 

Checker Account 
Setup and 
Options
- 8 Auto Mail Checker
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Special Group
You may add the e-mail addresses of those you wish to assign to your special
group here. The Mail LED  will then blink fast when mail is received from
members of this group, if LED notification is enabled in the control panel
(Figure 2 - 3).

Figure 2 - 4
Special Group Setup
Auto Mail Checker 2 - 9
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 Hard Disk Drive
The hard disk drive is used to store your data in the notebook computer. The
hard disk can be taken out to accommodate other 2.5" IDE hard disk drives
with a height of 9.5 mm.

The hard disk  is accessible from the bottom of your computer as seen be-
low. Further details on removing and inserting the hard disk are available in
“Upgrading the Hard Disk Drive” on page 6 - 4.

Power Safety

Before attempting to
access any of the inter-
nal components of
your notebook please
ensure that the ma-
chine is not connected
to the AC power, and
that the machine is
turned off. Also ensure
that all peripheral ca-
bles, including phone
lines, are disconnected
from the computer.

Figure 2 - 5
Hard Disk Location

1

Hard Disk

1

- 10 Hard Disk Drive
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Floppy Disk Drive (FDD)
The computer (only Model C does not have an FDD - see “Model Differ-
ences” on page 1 - 5) is equipped with a fixed 1.44 MB, 3.5" floppy disk drive
module. By default it is labeled “Drive A:”, and can be used as a boot device
if properly set in the BIOS (refer to “Boot Menu” on page 5 - 16).

Inserting/Removing Floppy Disks
When using the floppy drive, always insert your floppy diskette with the label-
side facing up. To remove the inserted diskette, press the eject button  on
the top-right corner of the floppy drive.

Media Warning

Don’t try to remove a
floppy disk while the
system is accessing it.
This may cause the
system to “crash”.

Figure 2 - 6
Floppy Disk Drive

1

Eject Button 1
Floppy Disk Drive (FDD) 2 - 11
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 CD/DVD Device
There is a bay for either a CD-ROM, or DVD-ROM, or CD-RW, or Combi-
nation CD-RW and DVD-ROM, or DVD-RW drive, depending on the model
you purchased. The CD Device is usually labeled “Drive D:”, and may be
used as a boot device if properly set in the BIOS (“Boot Menu” on page 5 -
16).

Loading Discs
To insert a CD/DVD, press the open button  and carefully place a CD/DVD
onto the disc tray with label-side facing up (use just enough force for the disc
to click onto the tray’s spindle). Gently push the CD/DVD tray in until its lock
“clicks” and you are ready to start. The busy indicator  will light up while
data is being accessed, or while an audio/video CD, or DVD, is playing. If
power is unexpectedly interrupted, insert an object such as a straightened pa-
per clip into the emergency eject hole  to open the tray.

Sound Volume 
Adjustment

How high the sound
volume can be set de-
pends on the setting of
the volume control
within Windows. Click
the Speaker icon on
the taskbar to check
the setting. 

All peripherals must be
connected before you
turn on the system.

Figure 2 - 7
CD Device

1

2

3

Eject Button
1 2 3
- 12 CD/DVD Device
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Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being damaged.
Please follow the advice below to make sure that the data stored on your CD-
ROMs/DVD-ROMs can be accessed.

Remember to:

• Hold the CD or DVD by the edges; do not touch the surface of the disc.
• Use a clean, soft, dry cloth to remove dust or fingerprints.
• Do not write on the surface with a pen.
• Do not attach paper or other materials to the surface of the disc.
• Do not store or place the CD or DVD in high-temperature areas.
• Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
• Do not bend the CD or DVD.
• Do not drop or subject the CD or DVD to shock.

CD Emergency Eject

If you need to manually
eject a CD (e.g. due to
an unexpected power
interruption) you may
push the end of a
straightened paper clip
into the emergency
eject hole. However
please do NOT use a
sharpened pencil or
similar object that may
break and become
lodged in the hole.
CD/DVD Device 2 - 13
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 DVD Regional Codes
DVD region detection is device dependent, not OS-dependent. You can select
your module’s region code 5 times. The fifth selection is permanent. This can-
not be altered even if you change your operating system or you use the module
in another computer. 

Figure 2 - 8
DVD Regional Codes

(Windows XP)
- 14 CD/DVD Device
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Changing DVD Regional Codes
Go to the Control Panel in WindowsXP/Windows 2000 and double-click Sys-
tem > Hardware (tab), click Device Manager, then click the + next to DVD/
CD-ROM drives. Double-click on the DVD-ROM device to bring up the
Properties menu, and select the DVD Region (tab) to bring up the control
panel as seen in “DVD Regional Codes (Windows XP)” on page 2 - 14. To
change the TV system to/from PAL or NTSC see “TV System (Advanced
Menu>Advanced Chipset Control)” on page 5 - 12. 

DVD Regional Coding

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South Africa, Middle East & Egypt

3 South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong 
Kong

4 South & Central America, Mexico, Australia, New Zealand

5 N Korea, Russia, Eastern Europe, India & Most of Africa

6 China

Table 2 - 3
DVD Regional Coding
CD/DVD Device 2 - 15
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 PC Card Slot
The computer (only Model C does not have a PC Card Slot - see “Model
Differences” on page 1 - 5) is equipped with a PCMCIA 3.3V/5V slot for one
type II PC Card. Make sure you install the driver for the PC Card (see “What
to Install” on page 4 - 1).

Inserting and Removing PC Cards 
• Align the PC Card with the slot and push it in until it locks into place.
• To remove a PC Card, simply press the eject button  next to the slot.Figure 2 - 9

PC Card Slot

1

1

- 16 PC Card Slot
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Hot-Keys
These keys access the internet, e-mail or a user-defined application with one
quick button press. To use the “user-defined Hot-Key”, you must install the
Hot-Key driver. Refer to “What to Install” on page 4 - 1 for driver installation
steps. 

Programming the Hot-Keys

After installing the Hot-Key driver you can configure or change the settings.

Hot-Key Function

Activate the default e-mail program

Activate the default Internet browser

Activate the user specified application e.g. Microsoft Word or Excel

Non-Default E-Mail 
and Browser 

Programs

It is possible to config-
ure both the e-mail and
browser Hot-Keys to
open non-default mail
and browser pro-
grams. Follow the pro-
cedure outlined on
page 2 - 18 but high-
light either the Brows-
er or Email in step 2.
Choose Custom to
browse to the program
of your choice as per
the remaining instruc-
tions. The Hot-Key will
now open this pro-
gram.

Table 2 - 4
Hot-Keys
Hot-Keys 2 - 17
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To configure and specify an application for Application 1 (the default Hot-
Key setting is for the CD Player/Media Player application), you must follow
the instructions below.

1. Right click the Hot-Key driver icon  on the taskbar and the following 
menu will appear.

2. Select Setup from the menu and scroll to Application 1 and press Enter. 

3. An Open dialog box will appear on the screen.

4. Browse to the directory where the desired application.exe (see the sidebar) 
program exists.

5. Double-Click on the program file or choose Open.
6. The Hot-Key is now set to execute that program.

Application.exe

You will need to locate
the actual application
executable (.exe) file,
not just the shortcut.
To find the application
right-click its shortcut
on the desktop and
click Properties. Click
the shortcut (tab) and
see where the execut-
able file is located by
clicking the Find Tar-
get (button).
- 18 Hot-Keys
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Function Keys and Numeric Keypad
Function Keys
On the bottom-left of the keyboard is the Fn key or Function key. The Fn key
allows you to change operational features instantly. To use the functions press
and hold the Fn key, then press the appropriate function key (F3 - F9 etc.) lo-
cated on your keyboard.

Keys Description

Fn Function Key

Fn + F3  Mute Toggle

Fn + F4 Sleep/Resume Toggle

Fn + F5 Decrease Audio Volume

Fn + F6 Increase Audio Volume

Fn + F7 Display Toggle

Fn + F8 Decrease LCD Brightness

Fn + F9 Increase LCD Brightness

Fn + F12 Multiple Wireless Modules Toggle

Fn + NumLk Number Lock Toggle

Fn + ScrLk Scroll Lock Toggle

Other Keyboards

If your keyboard is
damaged or you just
want to make a
change, you can use
any standard PS/2 or
USB keyboard. The
system will detect and
enable it automatically.
However special func-
tions/hot keys unique
to the system’s regular
keyboard may not
work.

Table 2 - 5
Function Keys
Function Keys and Numeric Keypad 2 - 19
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 Numeric Keypad
The keyboard has an embedded numerical keypad for easy numeric data input.
The numeric keys are highlighted by a yellow typeface.

Activate the Number Lock feature by pressing and holding the Fn key, then
press the NumLk key at the top right of the keyboard. You may check if Num-
ber Lock is enabled or not by looking at the LED status indicators (see “LED
Indicators” on page 2 - 5). If NumLk is enabled, you do not need to hold the
Fn key down to type a number from the numeric keypad.

Activate Scroll Lock by pressing and holding the Fn key, then press the Scr-
Lk key at the top right of the keyboard.

Special Characters

Some software appli-
cations allow the
number-keys to be
used with Alt to pro-
duce special charac-
ters. These special
characters can only be
produced by using the
numeric keypad. Reg-
ular number keys (in
the upper row of the
keyboard) will not
work. Make sure that
NumLk is on.

Figure 2 - 10
Keyboard

Numeric Keypad

Fn Key

Function Keys

NumLk & ScrLk
           Keys
- 20 Function Keys and Numeric Keypad
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TouchPad and Buttons/Mouse
The TouchPad is a device for pointing (controlling input positioning) on the
computer’s display screen by sensing finger movement, and downward pres-
sure. It is an alternative to the mouse, however, you can also add a mouse to
your computer either through the PS/2 interface, or one of the USB ports.

The TouchPad buttons function in much the same way as a two-button mouse.
The central button may be configured to function as you require (see “Mouse
Properties” on page 2 - 22 for screen examples).

Configuring the TouchPad and Buttons
Once you have installed the TouchPad drivers (see “What to Install” on
page 4 - 1) you can configure the functions by double-clicking the TouchPad
icon  in the taskbar, or by going to the Mouse control panel in Windows
(Start menu and point to Settings and click Control Panel, then double-click
the Mouse icon). In Windows XP the Mouse control panel is in the Printers
and Other Hardware Category.

Right-click the taskbar icon  and select Easy Launcher to
run programs from this menu. To add programs to the menu, see
“Easy Launcher” on page 2 - 22 for details.

Mouse Driver

If you are using an ex-
ternal mouse your op-
erating system may be
able to auto-configure
your mouse during its
installation or only ena-
ble its basic functions.
Be sure to check the
device’s user docu-
mentation for details.

TouchPad Taskbar 
Icon 

You can add the
TouchPad icon to the
taskbar from the
Mouse control panel,
in the Others tab. Re-
start the computer to
see the icon appear in
the taskbar.
TouchPad and Buttons/Mouse 2 - 21
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Easy Launcher

You can add programs
to the menu from the
Others tab in the
Mouse control panel.
Click on Settings for
Easy Launcher to get
the settings options.

Click the New button
and browse to any pro-
grams you wish to add
to the menu.

Restart the computer
and run Easy Launch-
er by right-clicking the
icon in the taskbar.

Click Close or Mini-
mize to quit the menu.

Figure 2 - 11
Mouse Properties
- 22 TouchPad and Buttons/Mouse
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Adding a Printer
The most commonly used peripheral is a printer. The following conventions
will help you to add a printer, however it is always best to refer to the printer
manual for specific instructions and configuration options.

USB Printer
Most new printers have a USB interface connection. You may use any of the
USB ports on your computer to connect the printer.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray, toner/

ink cartridge etc.). 
2. Turn ON the computer.
3. Turn ON the printer. 
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. Windows will identify the printer and either load one of its own drivers or ask 

you to supply one. Follow the on-screen instructions.
Adding a Printer 2 - 23
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 Parallel Printer
This is still the most common type of printer.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray, toner/

ink cartridge etc.).
2. Attach the parallel cable to the printer.
3. Connect the printer’s parallel cable to the parallel port at the rear of the 

computer (see “Rear View” on page 1 - 18).
4. Turn ON the printer.
5. Turn ON the computer.
6. Windows will identify the printer and either load one of its own drivers or 

ask you to supply one. Follow the on-screen instructions.
- 24 Adding a Printer
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Chapter 3: Advanced Controls
Overview
This chapter covers:

• Advanced video controls
• Power and battery management features

Note: All operating system pictures in this manual are from the Microsoft
Windows XP OS.

Drivers

You are unable to use
most advanced con-
trols until the neces-
sary drivers and
utilities are properly in-
stalled. If your system
hasn’t been properly
configured (your serv-
ice representative may
have already done that
for you), refer to “What
to Install” on page 4 -
1 for installation in-
structions.
Overview 3 - 1
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Advanced Video Controls
This section is about making adjustments for the LCD, and switching display
devices.

Opening the LCD
As you open the lid, adjust it so you can look at the screen straight on, without
any glare. If necessary, adjust the brightness controls (Fn + F8/F9).

Protecting the LCD

Do not allow any for-
eign objects (i.e. paper
or plastic) to get be-
tween the lid/LCD and
the work panel. They
could damage or
scratch the LCD and/or
accidentally activate
the close cover switch.

Figure 3 - 1
Brightness 

Controls Fn

F8 F9
- 2 Advanced Video Controls
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Video Driver Controls
The video interface lets you change the screen resolution and color output to
whatever is most comfortable/efficient for you. This is a matter of hardware,
video memory and the driver for your operating system. The driver interface
shows the available options (see “LCD Options” on page  A - 2 for the LCD
options).

You can switch display devices from the Display Properties control panel in
Windows as long as the video driver is installed (see “What to Install” on
page 4 - 1).

Making Adjustments for the Display
The higher the resolution you set the LCD for, the more information the LCD
can display on screen. To change the LCD’s resolution and color depth go to
the Display Properties control panel:

1. Click Start, point to Settings and click Control Panel (if you are in Cate-
gory View choose Appearance and Themes).

2. Double-click Display (icon).
3. In the Display Properties dialog box, click Settings (tab).
4. In Screen area/resolution, move the slider to the preferred setting for 

resolution (see  in Figure 3 - 2 on page 3 - 4).
5. In Colors/Color quality, click the arrow and scroll to the preferred setting 

for color depth (see  in Figure 3 - 2 on page 3 - 4).

Screen Resolution/
Screen Area Note

You may set the reso-
lution to a higher set-
ting than the panel
supports, however this
will require you to pan
(scroll) around the
screen as the display
area will be larger than
what you can see on
the LCD.

1

2

Video Driver Controls 3 - 3
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Display Properties

When the Display Properties control panel is open, click the Advanced 
(button) to bring up the options tabs. Clicking through these tabs allows you
to make any video adjustments you require.

Figure 3 - 2
Advanced Display 

Properties

1
2

3

3

- 4 Video Driver Controls
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SiS Utility Tray/Manager
With the video driver installed additional control panels are available. To
get to the control panels do the following:

1. Click Start, point to Settings and click Control Panel (if you are in Cate-
gory View choose Appearance and Themes).

2. Double-click Display (icon).
3. In the Display Properties dialog box, click Settings (tab).
4. Click Advanced (button), and click SiS Utility Manager (tab).
5. Choose the setting you wish to change.

OR
1. Right-Click the SiS Utility Tray icon in the taskbar.
2. Point to Display Property and choose the setting you wish to change.

Figure 3 - 3
SiS Utility Tray/

Manager

SiS Utility Tray icon
Video Driver Controls 3 - 5



Advanced Controls

3

3

You may make changes to the Driver Mode Settings, Video Settings, Gamma
Correction Settings, and view General Information, by clicking the appropri-
ate tab and adjusting the setting. Some screen examples are shown below.

Figure 3 - 4
SiS Utility Tray/

Manager Setting Tabs
- 6 Video Driver Controls
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Video Memory
The computer does not have dedicated video memory. It makes use of a por-
tion of system memory as video memory. By default, the video memory is set
to 32MB, and you may change the setting in the BIOS (see “Embedded Share
Memory (Advanced Menu>Advanced Chipset Control)” on page 5 - 11).
Bear in mind that the more overall memory is used as video memory, the less
is available as system memory. This memory is allocated from your system
memory e.g. if your computer has 128MB of memory (RAM), then 32MB will
be allocated to video leaving the system with 96MB of RAM.

Video Memory Usage

3D Applications, such
as games and CAD
software, tend to re-
quire more video mem-
ory than most other
applications. Check
your application’s user
documentation for vid-
eo memory require-
ments.
Video Memory 3 - 7



Advanced Controls

3

3

Display Devices
Besides the built-in LCD, you can also use an external VGA monitor (CRT)
or TV as your display device. A VGA monitor connects to the external mon-
itor (CRT) port , a TV to the S-Video Out port , as illustrated in Figure
3 - 5. The display options are as follows:

1. The built-in LCD (Single).
2. A VGA monitor connected to the external monitor (CRT) port at the rear of 

the computer (Single).
3.  A TV connected to the S-Video Out port at the rear of the computer 

(Single).
4. The built-in LCD and a VGA monitor showing the same image (Mirror).
5. The built-in LCD and a TV showing the same image (Mirror).
6. The built-in LCD and a VGA monitor showing different images 

(Multimonitor).
7. The built-in LCD and a TV showing different images (Multimonitor).
8. A VGA monitor and TV showing different images (Multimonitor) - see 

sidebar note.

The table on the following page shows the available options.

1 2
VGA Monitor and TV 

Display Setting

If you intend to use a
TV and VGA monitor
as your display devic-
es, the TV must be set
as the primary
Display_1, and the
VGA monitor as the
secondary Display_2
(Figure 3 - 14 on page
3 - 19).

Figure 3 - 5
External Monitor & 
S-Video-Out Ports

1 2
- 8 Display Devices
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Display Options

Display Mode Windows XP Windows 2000

Single

Mirror

Multimonitor Not Available

Single - Either the LCD, VGA monitor or TV as a display device.
Mirror - The LCD, VGA monitor or TV outputting the same view.
Multimonitor -The LCD, VGA monitor or TV outputting a different view (not 
available in Windows 2000).

Multiple Display 
Modes & DVD 

Playback

In Mirror mode DVD
movies must be dis-
played in the primary
device - see “Switch-
ing/Enabling Dis-
plays (Driver)” on
page 3 - 11.

DVD playback is not
supported in Multi-
monitor mode.

Table 3 - 1
Display Options
Display Options 3 - 9
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Switching/Enabling Displays (Keyboard)
To simply switch display devices, or enable other devices, with the Fn +
Display (F7) toggle do the following:

1. Plug the VGA monitor or TV into the appropriate port.
2. Press and hold the Fn key, while simultaneously pressing the F7 key.
3. You may toggle through the options to display the LCD only, the LCD 

and the external display together, and the external display alone 
(make sure you allow time for the screens to refresh as you toggle 
through).

Note: If you only use the keyboard toggle to switch through the display op-
tions you will not have all the configuration options available to you. If you
want to access the options listed in “Display Devices” on page 3 - 8 use
the driver control panel to configure the settings as per “Switching/En-
abling Displays (Driver)” on page 3 - 11.
- 10 Display Options
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Switching/Enabling Displays (Driver)
With the video driver installed (see “What to Install” on page 4 - 1), you
can use its built-in controls to switch between the displays as follows:

1. Plug the VGA monitor or TV into the appropriate port.
2. Following the instructions in “SiS Utility Tray/Manager” on page 3 - 

5, choose Driver Mode Setting.
3. If the device list box doesn’t show any plugged in devices, uncheck 

the Auto option.

See the following pages for instructions on enabling Mirror and Multi-
monitor modes.

Figure 3 - 6
Disable Auto
Display Options 3 - 11



Advanced Controls

3

3

Mirror Mode
In this mode the display of the two devices is the same. Mirror mode simply
shows an exact copy of the Primary display desktop on the Secondary dis-
play(s). This mode will drive multiple displays with the same content. Use this
feature to display the screen through a projector for a presentation etc.

Setting Mirror Mode
1. Follow the instructions in “Switching/Enabling Displays (Driver)” 

on page 3 - 11 (make sure Auto is unchecked).
2. Choose the Mirror option from the Driver mode drop box.
3. Choose a device to be Primary, and one to be Secondary.
4. Click OK > OK to apply the settings (you may need to give your VGA 

monitor a few seconds to refresh).
5. Click Yes to keep the settings.

Switching Display 
Modes

To switch back from
Multimonitor mode to
either Mirror or Single
mode, you will be re-
quired to restart the
computer.

Figure 3 - 7
Mirror Setting
- 12 Display Options
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Multimonitor
This mode allows a desktop to span the displays to act as a large work area,
thus creating a lot more screen area for display.

Setting Multimonitor Mode
1. Follow the instructions in “Switching/Enabling Displays (Driver)” 

on page 3 - 11 (make sure Auto is unchecked).
2. Choose the Multimonitor option from the Driver mode drop box.
3. Choose which device is to be Display_1, and which is to be 

Display_2 (the VGA option for the external monitor may only be set 
to Display_2).

4. Click OK > Yes to restart your computer.

Figure 3 - 8
Multimonitor Setting
Display Options 3 - 13
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Configuring Multimonitor Displays 
You can reconfigure the displays in Multimonitor mode from the Display
Properties > Settings control panel (see “Multimonitor Setting” on page 3 -
13). Make sure you have checked the “Extend my Windows desktop onto
this monitor.” check box as illustrated in Figure 3 - 9.

Use the Display Properties control panel to drag the monitors to match the
physical arrangement you wish to use. In the example shown in Figure 3 - 9
the primary monitor  is on the left, the secondary display is on the right.

With the Extended Desktop Mode enabled drag any icons or windows across
to the other display desktop. It is therefore possible to have one program vis-
ible in one of the displays, and a different program visible in the other display.

 

1

Figure 3 - 9
Extended Desktop 

Monitor Arrangement
- 14 Display Options
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Adjusting Monitor Settings
If you prefer to use a VGA monitor (CRT) you may change its vertical refresh
rate, color depth and resolution. 

In Multimonitor Mode
1. Follow the instructions in “Setting Multimonitor Mode” on page 3 - 13.
2. After the computer has restarted go back to the Driver Mode Setting 

control panel and select the refresh rate, resolution and color depth options 
available from the VGA drop box under Support Modes.

3. Click OK > OK > Yes to adjust and confirm the settings.

Vertical Refresh Rate

The vertical refresh rate
of your CRT is impor-
tant. If it is too low and/
or you’re using fluores-
cent lighting, the screen
will appear to flicker. To
reduce flickering on a
CRT, use faster refresh
rates (we recommend a
refresh rate of 72Hz or
more). But first check
your monitor’s docu-
mentation to make sure
it can support the rates
listed by the video driv-
er. The default refresh
rate for VGA monitors
(without drivers) is
60Hz.

Figure 3 - 10
Multimonitor VGA 

Support Modes
Adjusting Monitor Settings 3 - 15



Advanced Controls

3

3

You may also adjust the refresh rate from the Display Properties control
panel after Multimonitor mode has been enabled:

1. Double-click on the VGA monitor icon (in the example below it is the  icon 
as the VGA monitor is set for Display_2).

2. Click the Monitor tab, then select the refresh rate.
3. Click OK and close the Display Properties window.

Figure 3 - 11
Multimonitor - Set 

Refresh Rate (Display 
Properties) 

2

- 16 Adjusting Monitor Settings
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In Mirror or Single Mode
To change the refresh rate in Single or Mirror mode you will need to do the
following:

1. Follow the instructions in “Switching/Enabling Displays (Driver)” on 
page 3 - 11.

2. Choose the Mirror or Single option from the Driver mode drop box.
3. Set the VGA monitor as the Primary device.
4. You may then choose the refresh rate, resolution and color depth options 

available from the VGA drop box under Support Modes.
5. Click OK > OK > Yes to adjust and confirm the settings.

Setting Changes

Some setting changes
may require you to re-
start the computer.

Figure 3 - 12
Mirror/Single VGA 

Support Modes
Adjusting Monitor Settings 3 - 17
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You can also adjust the refresh rate from the Display Properties control panel
(click Advanced button and choose the Monitor tab):

1. Once the VGA monitor is confirmed as the Primary device, close the Dis-
play Properties control panel.

2. Open the Display Properties > Settings control panel again.
3. Double-click the monitor icon and select the Monitor tab.
4. Choose your preferred refresh rate and click OK, then close the Display 

Properties control panel.
Figure 3 - 13

 VGA Primary - 
Monitor Refresh 

Rate
- 18 Adjusting Monitor Settings
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TV Display
To display desktop images on a TV display, connect the TV to your com-
puter by using an S-Video cable from the TV to the S-Video-Out port at
the rear of the computer. Follow the instructions in “Switching/Enabling
Displays (Driver)” on page 3 - 11 to switch to a TV display. 

TV System
You can set the TV system as NTSC or PAL in the BIOS (see “TV System
(Advanced Menu>Advanced Chipset Control)” on page 5 - 12).

VGA Monitor and TV 
Display Setting

If you intend to use a
TV and VGA monitor
as your display devic-
es, the TV must be set
as the primary
Display_1, and the
VGA monitor as the
secondary Display_2
(see Figure 3 - 14).

Figure 3 - 14
VGA Monitor and 

TV Display
TV Display 3 - 19
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Power Management Features
To conserve power, especially when using the battery, your notebook comput-
er uses the ACPI power management system. Power management conserves
power by controlling individual components of the computer (the monitor and
hard disk drive) or the whole system.

Advanced Configuration and Power Interface
The ACPI interface provides the computer with enhanced power saving tech-
niques and gives the operating system (OS) direct control over the power and
thermal states of devices and processors. For example, it enables the OS to set
devices into low-power states based on user settings and information from ap-
plications. ACPI is fully supported in Windows 2000 and Windows XP.

Mobile CPU SpeedStep
If you have a mobile CPU, you can set power saving options in the BIOS set-
up program (see “Mobile CPU SpeedStep (Advanced Menu)” on page 5 -
10). SpeedStep will only take advantage of the enhanced capabilities of the
mobile CPU. If you are unsure of your CPU type check the POST screen in-
formation (see “The Power-On Self Test (POST)” on page 5 - 3).

OS Note

Power management
functions will vary
slightly depending on
your operating system.
For more information it
is best to refer to the
user’s manual of your
operating system. 

(Note: All pictures
used on the following
pages are from the
Windows XP OS.)
- 20 Power Management Features
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Enabling Power Options
Power Options are enabled through the control panel in your Windows sys-
tem (Power Options). With other operating systems you may have power
management available, so check your documentation.

You may conserve power through individual components or throughout the
whole system.

Figure 3 - 15
Power Options
Control Panel
Enabling Power Options 3 - 21
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Conserving Power (Individual Components)

Turn off Monitor
To conserve power, you can set the monitor to turn off after a specified time.

Turn off Hard Disk
The computer's hard disk motor will be turned off if the hard disk drive has
not been accessed for a specified period of time. If the system reads or writes
data, the hard disk motor will be turned back on.

Resuming Operation

The system can
resume from Monitor
or Hard Disk Standby
by pressing a key on
the keyboard.

Figure 3 - 16
Power Schemes
- 22 Enabling Power Options
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Conserving Power (System)
With this function you can stop the notebook’s operation and restart where
you left off. This system features Standby and Hibernate sleep mode levels
(Hibernate mode will need to be enabled by clicking the option in the Hiber-
nate tab in the Power Options control panel - Figure 3 - 17 on page 3 - 24).

Hibernate Mode vs. Shutdown
Hibernate mode and Shutdown are the same in that the system is off and you
need to press the power button to turn it on. Their main difference is:

When you come back from hibernation, you can return to where you last left
off (what was on your desktop) without reopening the application(s) and
file(s) you last used.

You can use either method depending on your needs. 

Standby Mode vs. Hibernate Mode
If you want to stay away from your work for just a while, you can put the sys-
tem on standby instead of in hibernation. It takes a longer time to wake up the
system from Hibernate mode than from Standby mode.
Enabling Power Options 3 - 23
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Standby
Standby saves the least amount of power, but takes the shortest time to return
to full operation. During Standby the hard disk is turned off, and the CPU is
made to idle at its slowest speed. All open applications are retained in memo-
ry. When you are not using your computer for a certain length of time, which
you specify in the operating system, it will enter Standby mode to save power. 

Hibernate
Hibernate uses no power and saves all of your information on a part of the
HDD before it turns the system off. Although it saves the most power it takes
the longest time to return to full operation. You can set your notebook to au-
tomatically enter Hibernate mode when the battery power is almost depleted.
You will need to enable Hibernate mode from the Hibernate tab in the Power
Options control panel. The system will resume from Hibernate mode by
pressing the power button.

System Resume

The system can
resume from Standby
mode by:

• Pressing the 
power button

• Pressing the key 
combination Fn + 
F4

• An alarm resume 
that is enabled and 
expires

• An incoming call 
received on the 
modem

Figure 3 - 17
Enable Hibernation
- 24 Enabling Power Options
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Configuring the Power Button
The power button may be set to send the computer in to either Standby or Hi-
bernate mode (Figure 3 - 18). In Standby mode, the LED  will flash
green, and in Hibernate mode the LED will be off. If you are in a power sav-
ing mode set to save power through individual components (e.g. hard disk,
monitor), the LED will remain green.

Sleep Button

You may also config-
ure the Sleep/Resume
key combination (Fn +
F4) from the menu il-
lustrated in Figure 3 -
18. In Windows this is
referred to as the
Sleep button.

Figure 3 - 18
Power Options

(Advanced - Power 
Buttons)

Power Button Sleep/Resume(Sleep)Button
Enabling Power Options 3 - 25
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Battery Information
Please follow these simple guidelines to get the best use out of your battery.

New Battery
Always completely discharge, then fully charge, a new battery before using it
(see “Battery FAQ” on page 3 - 27 for instructions on how to do this).

Battery Life
Your notebook computer’s battery life is dependent upon many factors, in-
cluding the programs you are running, and peripheral devices attached. Power
Options settings in the OS will help prolong the battery life if configured ap-
propriately.

Battery life may be shortened through improper maintenance. To optimize the
life and improve its performance, fully discharge and recharge the battery at
least once every 30 days.

We recommend that you do not remove the battery yourself. Please consult
your service representative should you need to remove the battery for any rea-
son.

Caution

Danger of explosion if
battery is incorrectly
replaced.

Replace only with the
same or equivalent
type recommended by
the manufacturer. Dis-
card used battery ac-
cording to the
manufacturer’s in-
structions.
- 26 Battery Information



Advanced Controls

3

Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery.
Don’t turn off the computer by yourself even when you see a message that in-
dicates the battery is critically low, just let the computer use up all of the bat-
tery power and shut down on its own. Disable the Power Options functions
in the Control Panel, especially any Alarms (unclick the tickboxes) and
Schemes (change all the settings to Never - see page 3 - 22). As the battery
nears the end of its life save and close any critical files.

How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light
turns from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or af-
ter about 20 partial discharges.

Conserving Battery Power
The LCD display consumes a lot of power, so lowering the brightness level
will save power. Different applications and external devices consume battery
power even when they are not being used (see the sidebar note for further
recommendations on battery conservation).

Conserving Battery 
Power

To conserve battery
power:

Close modem or com-
munication applica-
tions when they are not
being used.

Remove any unused
PC Cards from the
computer (PC Cards
quickly use up battery
power even if the sys-
tem enters sleep
mode).

Disconnect any unnec-
essary external devic-
es.
Battery Information 3 - 27
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Configuring the Infrared Settings for FIR
Depending on the configuration purchased (Model C computers do not have
an infrared transceiver - see “Model Differences” on page 1 - 5), you will
need to change the settings for the infrared device in the BIOS (see “I/O De-
vice Configuration (Advanced Menu)” on page 5 - 13) to enable the FIR set-
ting support.

To configure your computer for Fast Infrared (FIR) communication follow
these steps:

1. Click Start, point to Settings and click Control Panel.
2. Double-click Wireless Link icon.
3. Click Hardware (tab), then click Properties (button).
4. Select Advanced (tab).
5. Select “Infrared Transceiver A” and change the Value to “HP HSDL-

2300/3600”.
6. Click OK > OK.

For further information, please refer to the manual of the device you wish to
connect. 

Infrared 
Communication

The infrared transceiv-
er operates on a “Line
of Sight”.

Make sure nothing is
blocking the “Line of
Sight” between your
system’s transceiver
and the destination’s
transceiver.
- 28 Configuring the Infrared Settings for FIR
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Chapter 4: Drivers & Utilities
Overview
This chapter deals with installing the drivers and
utilities essential to the operation or improvement
of some of the computer’s subsystems. The system
takes advantage of some newer hardware compo-
nents for which the latest versions of most available
operating systems haven’t built in drivers and utili-
ties. Thus, some of the system components won’t
be auto-configured with an appropriate driver or
utility during operating system installation. Instead,
you need to manually install some system-required
drivers and utilities. In this chapter, we group driver
and utility installation instructions by operating
system. The following operating systems are cov-
ered.

• Windows 2000 Professional
• Windows XP

What to Install
The Device Drivers & Utilities + User’s Manual
CD-ROM contains the drivers and utilities neces-
sary for the proper operation of the computer.
Table 4 - 1 on page 4 - 5 lists what you need to in-
stall manually according to your choice of the oper-
ating system. It is very important that the drivers
are installed in the order indicated in the table.

Assumption

We assume that you will install all drivers and utilities
from the built-in CD device and it is assigned to “Drive
D:”. In addition, all file extensions can be seen [see
“Navigate (Browse...) to D:” on page 4 - 3].
Overview 4 - 1
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Optional Module Drivers
The procedures for installing drivers for the op-
tional Wireless LAN, PC Camera and Bluetooth
modules are provided in “Optional Modules” on
page 7 - 1. Make sure that the drivers are installed
in the order indicated in Table 4 - 1 on page 4 - 5.
If your purchase does not include any of the option-
al modules, DO NOT Install the drivers for them.

Windows 2000 & Windows XP Service Pack

Make sure you install Windows 2000 Service Pack
4 (or a version of Windows 2000 which includes SP4)
before installing any drivers. Service Pack 4 in-
cludes support for USB 2.0. 

Make sure that you install Windows XP Service
Pack 1a before installing all the drivers (if your
Windows XP version includes Service Pack 1a you
can skip this step). Service Pack 1a includes support
for USB 2.0.

Wireless Module ON/OFF Switch

While installing the drivers make sure that the
Wireless Module ON/OFF switch is turned OFF,
until you come to install the drivers for the 802.11b
Wireless LAN or Bluetooth modules. Before install-
ing the 802.11b Wireless LAN or Bluetooth drivers
turn the switch ON. If you have both the 802.11b
Wireless LAN and Bluetooth modules, use the Fn +
F12 key combination to toggle the power to the mod-
ule(s). See “Wireless LAN & Bluetooth Modules”
on page 7 - 2 for more information. If the Found New
Hardware Wizard appears at any time (other than
when outlined in the driver install procedure), click
Cancel.
- 2 What to Install
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Authorized Driver Message
If you receive a message telling you that the driver
you are installing is not authorized (Digital Signa-
ture Not Found), just click Yes or Continue Any-
way to ignore the message and continue the
installation procedure.

You will receive this message in cases where the
driver has been released after the version of Win-
dows you are currently using. All the drivers pro-
vided will have already received certification for
Windows.

Version Conflict Message
During driver installation if you encounter any “file
version conflict” message, please click the default
option offered by Windows (this will be the high-
lighted option).

Navigate (Browse...) to D:

You will notice that many of the instructions for driver
installation require you to “Navigate (Browse...) to
D:”.

In this case “D:” is the drive specified for your CD de-
vice. Not all computers are setup the same way, and
some computers have the CD listed under a different
drive letter - e.g. if you have two hard drives (or hard
disk partitions) one may be designated as “Drive C:”
and the other as “Drive D:”. In this case the CD device
may be designated as “Drive E:” - Please make sure
you are actually navigating to the correct drive letter
for the CD device.

When you click the Browse (button) after clicking
Run in the Start menu you will see the “Look in:” di-
alog box at the top of the Browse window. Click the
scroll button to navigate to My Computer to display
the devices and drive letters.
What to Install 4 - 3
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Updating/Reinstalling Individual 
Drivers
If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.
To do this go to the Control Panel in the Windows
OS and double-click the Add/Remove Programs
item. If you see the individual driver listed (if not
see below), uninstall it, following the on screen
prompts (it may be necessary to restart the comput-
er). Go to the appropriate section of the manual to
complete the update/reinstall procedure for the
driver in question.

If the driver is not listed in the Add/Remove Pro-
grams item:

1. Click Start (menu), point to Settings and click 
Control Panel. Double-click System (icon) 
and then click Hardware (tab) > Device Man-
ager (button).

2. Double-click the device you wish to update/
reinstall the driver for (you may need to click 
“+”).

3. Look for the Update Driver button (check the 
Driver tab) and follow the on screen prompts.
- 4 What to Install
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Table 4 - 1
Install Procedure

Feature Windows 2000 Windows XP

Audio page 4 - 6 page 4 - 10

Modem page 4 - 7 page 4 - 10

Network (LAN) page 4 - 7 page 4 - 10

Video page 4 - 7 page 4 - 10

PC Card/PCMCIA page 4 - 7 page 4 - 11

PC Camera See page 7 - 11 See page 7 - 12

Hot-Key page 4 - 8 page 4 - 11

TouchPad page 4 - 8 page 4 - 11

Wireless LAN See page 7 - 3 See page 7 - 4

Bluetooth See page 7 - 5 See page 7 - 7

Auto Mail page 4 - 8 page 4 - 12
What to Install 4 - 5
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Windows 2000 Professional
This section covers driver and utility installation in-
structions for Windows 2000 Professional.

New Hardware Found
If you see the message “New Hardware Found”
(Found New Hardware Wizard) during the
installation procedure (other than when outlined in
the driver install procedure), click Cancel to close
the window, and follow the installation procedure
as directed.

Audio (Win2000)
1. Click Start (menu) > Run...
2. Navigate (Browse...) to 

D:\Drivers\Audio\Setup.exe and click OK > 
Next.

3. Click Finish to restart your computer.
4. You can click the AC97 Audio Configuration 

icon  in the taskbar for configuration options.

Windows 2000 Service Pack 4 

Make sure that you install Windows 2000 Service
Pack 4 (or a version of Windows 2000 which includes
SP4) before installing all the drivers. Service Pack
4 includes support for USB 2.0.

Wireless Module ON/OFF Switch

While installing the drivers make sure that the
Wireless Module ON/OFF switch is turned OFF,
until you come to install the drivers for the 802.11b
Wireless LAN or Bluetooth modules. Before install-
ing the 802.11b Wireless LAN or Bluetooth drivers
turn the switch ON. If you have both the 802.11b
Wireless LAN and Bluetooth modules, use the Fn +
F12 key combination to toggle the power to the mod-
ule(s). See “Wireless LAN & Bluetooth Modules”
on page 7 - 2 for more information. If the Found New
Hardware Wizard appears at any time (other than
when outlined in the driver install procedure), click
Cancel.
- 6 Windows 2000 Professional
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Modem (Win2000)
1. Click Start (menu) > Run...
2. Navigate (Browse..) to 

D:\Drivers\MODEM\WIN2000\Setup.exe 
and click OK.

3. The driver will install and quit the installer 
menu automatically. The modem is ready for 
dial-up configuration.

LAN (Win2000)
1. Click Start (menu) > Run...
2. Navigate (Browse... to 

D:\Drivers\lan\Setup.exe and click OK.
3. To continue click Next.
4. Click Finish, then restart the computer.
5. The network settings can now be configured.

Video (Win2000)
1. Click Start (menu) > Run...
2. Navigate (Browse...) to 

D:\Drivers\Video\Setup.exe and click OK.
3. Click Next > Next > Next > Next.
4. Click Finish to restart the computer.
5. See “Advanced Video Controls” on page 3 - 2 

for details on adjusting the video settings.

PC Card/PCMCIA (Win2000)
No driver installation is required for Model C com-
puters.

1. Click Start (menu) > Run...
2. Navigate (Browse...) to 

D:\Drivers\PCMCIA\Setup.exe and click 
OK.

3. Click Next > Next.
4. Click Finish  to restart your computer.

PC Camera (Win2000)
See install procedure in “PC Camera Driver In-
stallation (Win2000)” on page 7 - 11.

Modem Country Selection

Be sure to check if the modem country selection is ap-
propriate for you (Control Panel > Phone and Mo-
dem Options and select a Country).
Windows 2000 Professional 4 - 7



Drivers & Utilities

4

4

Hot-Key (Win2000)
1. Click Start (menu) > Run...
2. Navigate (Browse...) to 

D:\Drivers\Hotkey\Setup.exe and click OK.
3. Choose the language you prefer, and click OK.
4. Click Next.
5. Click Finish to restart your computer.
6. You may then configure your Hot-Key buttons 

as outlined in “Hot-Keys” on page 2 - 17.

TouchPad (Win2000)
1. Click Start (menu) > Run...
2. Navigate (Browse...) to 

D:\Drivers\touchpad\Setup.exe and click 
Open > OK.

3. To continue click Next > Next (click Yes if 
asked if you want to continue).

4. Click Finish to restart your computer.
5. You may then configure your TouchPad as 

outlined in “Configuring the TouchPad and 
Buttons” on page 2 - 21.

Wireless LAN (Win2000)
See install procedure in “Wireless LAN Driver In-
stallation (Win2000)” on page 7 - 3.

Bluetooth (Win2000)
See install procedure in “Bluetooth Driver Instal-
lation (Win2000)” on page 7 - 5.

Auto Mail (Win2000)
1. Click Start (menu) > Run...
2. Navigate (Browse...) to 

D:\Drivers\AutoMail\Setup.exe and click 
OK.

3. To continue click Next > Next.
4. Click Finish, then restart your computer.
5. Run the program from the Start menu (point to 

Programs > Auto Mail Checker and click 
Auto Mail Checker). 

6. Double-click the taskbar icon to access the 
settings menus (see “Auto Mail Checker” on 
page 2 - 7).
- 8 Windows 2000 Professional
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Windows XP
This section covers driver and utility installation in-
structions for Windows XP.

New Hardware Found
If you see the message “New Hardware Found”
(Found New Hardware Wizard) for the Univer-
sal Serial Bus (USB) Controller during the instal-
lation procedure, click Cancel to close the window,
and follow the installation procedure as directed.

Driver Installation and Multi Language Options

Make sure you have not enabled any of the Multi lan-
guage options in the Regional and Language Op-
tions control panel before installing the drivers. Some
of these language options will interfere with the driver
installation process for the Audio driver. After you
have installed all the drivers you may then configure
the language options.

Windows XP Service Pack 1a

Make sure that you install Windows XP Service
Pack 1a before installing all the drivers (if your
Windows XP version includes Service Pack 1a you
can skip this step).

Wireless Module ON/OFF Switch

While installing the drivers make sure that the
Wireless Module ON/OFF switch is turned OFF,
until you come to install the drivers for the 802.11b
Wireless LAN or Bluetooth modules. Before install-
ing the 802.11b Wireless LAN or Bluetooth drivers
turn the switch ON. If you have both the 802.11b
Wireless LAN and Bluetooth modules, use the Fn +
F12 key combination to toggle the power to the mod-
ule(s). See “Wireless LAN & Bluetooth Modules”
on page 7 - 2 for more information. If the Found New
Hardware Wizard appears at any time (other than
outlined in the driver install procedure), click Cancel.
Windows XP 4 - 9
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Audio (WinXP)
1. Click Start (menu) > Run...
2. Navigate (Browse...) to 

D:\Drivers\Audio\Setup.exe and click OK > 
Next.

3. Click Finish to restart your computer.
4. You can click the AC97 Audio Configuration 

icon  in the taskbar for configuration options.

Modem (WinXP)
1. Click Start (menu) > Run...
2. Navigate (Browse...) to 

D:\Drivers\MODEM\WINXP\Setup.exe and 
click OK.

3. The driver will install and quit the installer 
menu automatically. The modem is ready for 
dial-up configuration.

LAN (WinXP)
1. Click Start (menu) > Run...
2. Navigate (Browse...) to 

D:\Drivers\lan\Setup.exe and click OK.
3. To continue click Next.
4. Click Finish, then restart the computer.
5. The network settings can now be configured.

Video (WinXP)
1. Click Start (menu) > Run...
2. Navigate (Browse...) to 

D:\Drivers\Video\Setup.exe and click OK.
3. Click Next > Next > Next > Next.
4. Click Finish to restart the computer.
5. See “Advanced Video Controls” on page 3 - 2 

for details on adjusting the video settings.

Modem Country Selection

You can change the modem country selection in the
control panel (Control Panel > Phone and Modem
Options (icon) and select a Country).
- 10 Windows XP
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PC Card/PCMCIA (WinXP)
No driver installation is required for Model C com-
puters.

1. Click Start (menu) > Run...
2. Navigate (Browse...) to 

D:\Drivers\PCMCIA\Setup.exe and click 
OK.

3. Click Next > Next.
4. Click Finish to restart your computer.

PC Camera (WinXP)
See install procedure in “PC Camera Driver In-
stallation (WinXP)” on page 7 - 12.

Hot-Key (WinXP)
1. Click Start (menu) > Run...
2. Navigate (Browse...) to 

D:\Drivers\Hotkey\Setup.exe and click OK.
3. Choose the language you prefer, and click OK.
4. Click Next.
5. Click Finish to restart your computer.
6. You may then configure your Hot-Key buttons 

as outlined in “Hot-Keys” on page 2 - 17.

TouchPad (WinXP)
1. Click Start (menu) > Run...
2. Navigate (Browse...) to 

D:\Drivers\touchpad\Setup.exe and click OK.
3. Click Next(click Continue Anyway if asked if 

you want to continue).
4. Click Finish to restart your computer.
5. You may then configure your TouchPad as 

outlined in “Configuring the TouchPad and 
Buttons” on page 2 - 21.
Windows XP 4 - 11
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Wireless LAN (WinXP)
See install procedure in “Wireless LAN Driver In-
stallation (WinXP)” on page 7 - 4.

Bluetooth (WinXP)
See install procedure in “Bluetooth Driver Instal-
lation (WinXP)” on page 7 - 7.

Auto Mail (WinXP)
1. Click Start (menu) > Run...
2. Navigate (Browse...) to 

D:\Drivers\AutoMail\Setup.exe and click 
OK.

3. To continue click Next > Next.
4. Click Finish, then restart your computer.
5. Run the program from the Start menu (point to 

Programs/All Programs > Auto Mail 
Checker and click Auto Mail Checker).

6. Double-click the taskbar icon to access the 
settings menus (see “Auto Mail Checker” on 
page 2 - 7).
- 12 Windows XP
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Chapter 5: BIOS Utilities
Overview
This chapter gives a brief introduction to the computer’s built-in software: 

Diagnostics: The POST (Power-On Self Test)

Configuration: The Setup utility 
If your computer has never been set up, or you are making important changes
to the system (e.g. hard disk setup), then you should review this chapter first
and note the original settings found in Setup. Even if you are a beginner, keep
a record of the settings you find and any changes you make. This information
could be useful if your system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what
you are doing. Many of the settings are required by the system, and changing
them could cause it to become unstable or worse. If you have any doubts, con-
sult your service representative. 

BIOS Settings 
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to
Setup and restore the
Setup Defaults with
<F9>.
Overview 5 - 1
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Important BIOS Settings
Generally speaking you should not have to adjust any of the BIOS settings, as
they will already be set for your computer. However the following is a quick
reference to the most important settings you may need to change at some
point.

Option Page # Purpose

Embedded 
Share 
Memory

5 - 11 Specifies the amount of total memory to be allo-
cated to video memory.

TV System 5 - 12
This item allows you to switch between NTSC and 
PAL TV systems when connecting a TV to the S-
Video Out port.

Boot Order 5 - 16
Specifies the order of the devices on which the com-
puter searches for an operating system (OS) as it 
starts up.

Table 5 - 1
Important BIOS 

Settings
- 2 Important BIOS Settings



BIOS Utilities

5

The Power-On Self Test (POST)
Each time you turn on the computer, the system takes a few seconds to con-
duct a POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong.
If there is a problem that prevents the system from booting, it will display a
system summary and prompt you to run Setup. 

If there are no problems, the Setup prompt will disappear and the system will
load the operating system. Once that starts, you can’t get into Setup without
rebooting.

POST Screen

1.BIOS information
2.CPU type 
3.Memory status
4.HDD identification

notice 
5.Enter Setup prompt

appears only during
POST

Note: The POST
screen as pictured is
for guideline purposes
only. The POST
screen on your compu-
ter may appear slightly
different.

Figure 5 - 1
POST Screen

Phoenix Bios 4.0 Release 6.0
Copyright 1985 - 2002 Phoenix Technologies Ltd.
All Rights Reserved
BIOS Revision: 1.00.T08
KBC/EC Revision: 1.00.04

CPU = Intel(R) Pentium(R) 4 CPU 3.06GHz
639K System RAM Passed
477M Extended RAM Passed
512K Cache SRAM Passed
32M Video RAM Passed
System BIOS shadowed
Fixed Disk 0: IC25N030ATCS04-0
ATAPI CD-ROM: DV-28E-B
Mouse Intialized
System Configuration Data updated

Press <F2> to enter SETUP

1

2
3

4

5

The Power-On Self Test (POST) 5 - 3
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Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and
“non-fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously
wrong with your system. Take the computer to your service representative or
authorized service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying
the problem (make a note of this message!) followed by the prompt:

• Press <F1> to resume
• <F2> to enter Setup 

Press F1 to see if the boot process can continue. It may work, without the cor-
rect configuration. 

Press F2 to run the Setup program and try to correct the problem. If you still
get an error message after you change the setting, or if the “cure” seems even
worse, call for help.

QuickBoot Mode

If you choose the
QuickBoot Mode (not
available for all mod-
els) in the Setup utility,
you will only see an ab-
breviated version of
the POST screen seen
in Figure 5 - 1 (see
“Advanced Menu” on
page 5 - 9).
- 4 The Power-On Self Test (POST)
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The Setup Program
The Phoenix Setup program tells the system how to configure itself and man-
age basic features and subsystems (e.g. port configuration).

Entering Setup
To enter Setup, turn on the computer and press F2 during the POST. The
prompt (“Press F2 to Enter Setup”) seen in Figure 5 - 1 is usually present
for a few seconds after you turn on the system. If you get a “Keyboard Error”,
(usually because you pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combina-
tion and then hold down F2 when prompted. The Setup main menu will ap-
pear.
The Setup Program 5 - 5
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Setup Screens
The following pages contain additional advice on portions of the Setup.

Along the top of the screen is a menu bar with five (5) menu headings. When
you select a heading, a new screen appears. Scroll through the features listed
on each screen to make changes to Setup.

Instructions on how to navigate each screen are in the box along the bottom of
the screen. If these tools are confusing, press F1 to call up a “General Help”
screen, then use the arrow keys to scroll up or down the page.

The “Item Specific Help” on the right side of each screen explains the high-
lighted item and has useful messages about its options.

If you see an arrow  next to an item, press Enter to go to a sub-menu on that
subject. The sub-menu screen that appears has a similar layout, but the Enter
key may execute a command.

Setup Menus

The Setup menus
shown in this section
are for reference only.
Your computer’s men-
us will indicate the con-
figuration appropriate
for your model and op-
tions.
- 6 The Setup Program
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Main Menu

System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 pm). If
you can change the date and time settings in your operating system, you will
also change these settings. Some applications may also alter data files to re-
flect these changes.

Figure 5 - 2
Main Menu

PhoenixBIOS Setup Utility

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

<Tab>, <Shift Tab>, or
<Enter> selects field.

System Time: [22:11:05]
System Date: [11/26/2002]

Legacy Diskette A: [1.44 MB 3½"]

�Primary Master [TOSHIBA MK3018GAP-(PM)]
�Secondary Master [QSI DVD-ROM SDR-083-(SM)]

System Memory: 640 KB
Extended Memory: 1012736 KB

Main

13
Main Menu 5 - 7
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Primary Master (Main Menu)
Pressing Enter under opens the sub-menu to show the configuration of the
HDD that fits into the computer’s HDD bay. These items are configured au-
tomatically for you.

Secondary Master (Main Menu)
Pressing Enter under opens the sub-menu to show the configuration of the CD
device. These items are configured automatically for you.

Switching Hard Disks

Every time you install a
different hard disk in
the computer, it will be
(configured automati-
cally.
- 8 Main Menu
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Advanced Menu

Installed O/S: (Advanced Menu)
This item tells the computer what operating system you’re using: Windows
2000, Windows XP use the same default setting Win2000/XP.

Figure 5 - 3
Advanced Menu

PhoenixBIOS Setup Utility

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Select the operating
system installed
on your system which
you will use most
commonly.

Note: An incorrect
setting can cause
some operating
systems to display
unexpected behavior.

Setup Warning
Setting itmes on this menu to incorrect
values may cause your system to malfunction.

Installed O/S: [Win2000/XP]

Intel On-Screen Branding Logo [Disabled]

Mobile CPU SpeedStep: [Auto]
Hyper-Threading [Disabled]

�Advanced Chipset Control
�I/O Device Configuration

USB Host Controller: [Enabled]
USB 2.0 Host: [Enabled]

Reset Configuration Data: [No]

Advanced

Win2000/XP

Mobile CPU 
SpeedStep and 

Hyper-Threading

Either the Mobile CPU
SpeedStep or the Hy-
per-Threading Tech-
nology option will only
appear if you have a
CPU that supports ei-
ther one of these fea-
tures. Both menu
options will appear to-
gether if your CPU
supports both.
Advanced Menu 5 - 9
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Intel On-Screen Branding Logo (Advanced Menu)
Set this item to enable or disable the Intel logo display on the screen.

Mobile CPU SpeedStep (Advanced Menu)
If your computer has the mobile CPU option Speedstep technology automat-
ically detects whether the notebook is running from AC power or battery pow-
er. When the notebook is using AC Power, the CPU will run at full speed. In
battery mode the CPU will reduce its clock speed and core voltage. By doing
this the CPU will consume less power, thus extending battery life. The default
mode (Auto) detects if the notebook is running from AC power or battery
power, and makes adjustments accordingly. SpeedStep will only take advan-
tage of the enhanced capabilities of the mobile CPU. If you are unsure of your
CPU type check the POST screen information (see “The Power-On Self Test
(POST)” on page 5 - 3).

Models Mobile CPU SpeedStep

Model A No

Model B Yes

Model C No

Model D Desktop CPU = No Mobile CPU = Yes
- 10 Advanced Menu
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Hyper-Threading (Advanced Menu) - Model D only
You can enable (it is Disabled by default) Hyper-Threading if your computer
has a processor with Hyper-Threading Technology (see below), running the
Windows XP OS. Hyper-Threading will increase performance of your com-
puter depending on the hardware and software you use. If you do not have a
processor with Hyper-Threading Technology, this menu option will not
appear. DO NOT enable this option in Windows 2000. Once you have en-
abled Hyper-Threading, DO NOT disable the option.

The following CPUs support Hyper-Threading:
• Intel Pentium 4 Processor (533MHz FSB) - 3.06 GHz
• Mobile Intel Pentium 4 Processor with Hyper-Threading Technology 

(533MHz FSB) - 2.66/ 2.8/ 3.06 GHz

Embedded Share Memory (Advanced Menu>Advanced Chipset Control)
This item tells the computer how much system memory (RAM) can be shared
to become available as video memory. By default, the video memory is set to
32MB. The more system memory used as video memory, the less is available
as system memory (e.g. if your computer has 128MB of RAM, then 32MB
will be allocated to video, leaving the system with 96MB of RAM).

Hyper-Threading

To use Hyper-Threading
you must have a computer
with a processor with Hy-
per-Threading Technol-
ogy, running the
Windows XP OS. The
menu option will not ap-
pear if your CPU does not
support Hyper-Threading.

If you are updating your
BIOS from a previous ver-
sion which did not have
the Hyper-Threading op-
tion, you must reinstall
Windows XP after you
have updated your
BIOS.

If you are changing your
processor from a CPU
which supports Hyper-
Threading, to one which
does not, you will need to
reinstall your OS.
Advanced Menu 5 - 11
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Graphics Aperture (Advanced Menu>Advanced Chipset Control)
The AGP aperture is an area of system RAM reserved for use by the comput-
er’s video system for storing textures if it needs. The RAM is available for use
by the system as normal if not used by the video system. The recommended
setting is 64MB, and this is the default setting. This setting should not be set
lower than 32MB.

TV System (Advanced Menu>Advanced Chipset Control)
This item allows you to switch between NTSC and PAL TV systems when
connecting a TV to the S-Video Out port.

TV Scan MODE (Advanced Menu>Advanced Chipset Control)
This item allows you to change the TV Scan Line Mode Option for a TV
connected to the S-Video-Out port (check your TV manual if you are un-
sure of the setting).

Embedded Modem Device/Audio Device/1394 Device (Advanced Menu
>Advanced Chipset Control)
These items allow you to disable these devices, should you need to do so.
- 12 Advanced Menu
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I/O Device Configuration (Advanced Menu)
The sub-menus under this item include options to configure the Serial port A
(Serial Mouse), Serial port B (Infrared - only Model C computers do not
have an infrared transceiver) and Parallel (Printer) port. These can be left to
the default settings, however you may wish to use certain devices that require
settings to be adjusted accordingly. Check the documentation for any such de-
vices to see what settings are required.

USB Host Controller (Advanced Menu)
This item allows you to enable or disable support for USB hardware.

USB 2.0 Host (Advanced Menu)
This item allows you to enable or disable support for SiS embedded USB
EHCI 2.0 hardware.

Reset Configuration Data (Advanced Menu)
This item is set to No as default. You can change the setting to Yes if you have
installed a new add-on which has reconfigured the system, resulting in such a
serious system conflict that the operating system is unable to boot.
Advanced Menu 5 - 13
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Security Menu

Security Menu
The changes you make here affect the access to the Setup utility itself, and
also access to your machine as it boots up after you turn it on. These settings
do not affect your machine or network passwords which will be set in your
software OS.

Figure 5 - 4
Security Menu

PhoenixBIOS Setup Utility

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Supervisor Password
controls access to the
setup utility.

Security

Supervisor Password Is: Clear

Set Supervisor Password [EEnter]

Fixed disk boot sector: [Normal]

Password on boot: [Disabled]
- 14 Security Menu
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Set Supervisor Password: (Security Menu)
Set a password for access to the Setup utility (this will not affect access to the
computer OS, only the Setup utility).

Fixed disk boot sector: (Security Menu)
Choose Write Protect to protect the area of the hard disk containing informa-
tion on how to start up the computer from having information written to it.
This helps prevent viruses from affecting this area, however, it is not a substi-
tute for proper virus protection supplied by updated anti-virus software. This
is merely an extra safeguard (see “Viruses” on page 8 - 4).

Password on boot: (Security Menu)
After setting the supervisor password, you can choose Enabled to set a pass-
word (the supervisor password) for booting the computer. Only users who en-
ter a correct password can boot the system (see “Warning” in the sidebar).

Password Warning

If you choose to set a
boot password, NEV-
ER forget your pass-
word.

The consequences of
this could be serious. If
you cannot remember
your boot password
you must contact your
vendor and you may
lose all of the informa-
tion on your hard disk.
Security Menu 5 - 15
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Boot Menu

Boot Menu
When you turn the computer on it will look for an operating system (e.g. Win-
dows 2000) from the devices listed in this menu, and in this order. If it cannot
find the operating system on that device, it will try to load it from the next de-
vice in the order specified in the Boot Menu.

Figure 5 - 5
Boot Menu

Model Differences

Only Model C comput-
ers do not have floppy
disk drives (see “Mod-
el Differences” on
page 1 - 5).

PhoenixBIOS Setup Utility

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Keys used to view or
configure devices:
<Enter> expands or
collapses devices with
a + or -
<Ctrl+Enter> expands
all
<Shift+1> enables or
disables a device.
<+> and <-> moves the
device up or down.
<n> May move removable
device between the Hard
Disk or Removable Disk
<d> Remove a device
that is not installed.

Removable Devices
CD-ROM Drive
Hard Drive
Network Boot

Boot
- 16 Boot Menu
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Boot devices usually are hard drives, floppy drives, CD-ROMs and LANs
(Local Area Networks).

When you specify a device as a boot device in the Boot Menu, it requires the
availability of an operating system on that device. Most home computers
come with an operating system already installed on “Drive C:”.

If you wish to boot from a CD-ROM you will need to add it to the boot order.
As a general rule the order below is recommended:

1. Removable Devices (usually floppy disks)
2. CD-ROM Drive
3. Hard Drive
4. Network Boot

In everyday use you will usually boot from the hard drive, however there may
be occasions when it is advantageous to boot from a floppy disk or CD-ROM.

To boot from the network see “Enabling Network Boot” on page 5 - 18.
Boot Menu 5 - 17



BIOS Utilities

5

5

Configuring the Network Boot Protocol
The system supports booting from FDD, HDD, CD or LAN (network). To
boot from a network, set Network Boot as the first item in the boot order. Fol-
low the full instructions in the sidebar to configure the network boot protocol.

Enabling Network 
Boot

Go to the Boot Menu.

Set the Network Boot
option as the first prior-
ity in the list.

Save the changes and
exit.

At startup, press and
hold the Shift and F10
keys.

Configure the network
protocol.

Save the settings to
automatically boot
from the network.

Realtek RTL8139(X)/8130/810X Boot Agent
Press Shift-F10 to configure .........

Realtek RTL8139(X/8130/810X Boot Agent
Configuration Menu v2.13

Network Boot Protocol PXE
Boot Order Int 19h
Show Config Message Enable
Show Message Time 3 Seconds

PXE

Always boot network first, then local devices

<Esc> <Space> <Enter> <F4>
Quit Change Value Next Option Save/Quit

Figure 5 - 6
Boot Agent Menu
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Exit Menu

Exit Menu
Choosing to Discard Changes, or Exit Discarding Changes, will wipe out
any changes you have made to the Setup. You can also choose to restore the
original Setup defaults that will return the Setup to its original state, and erase
any previous changes you have made in a previous session.

Figure 5 - 7
Exit Menu

PhoenixBIOS Setup Utility

Main Advanced Security Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Exit System Setup and
save your changes to
CMOS.

Exit Saving Changes
Exit Discarding Changes
Load Setup Defaults
Discard Changes
Save Changes

Exit
Exit Menu 5 - 19
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Chapter 6: Upgrading The Computer
Overview
This chapter contains information on upgrading the computer. Follow the
steps outlined to make the desired upgrades. If you have any trouble or prob-
lems you can contact your service representative for further help. Before you
begin you will need:

• A small crosshead or Phillips screwdriver
• A small regular slotted screwdriver
• An antistatic wrist strap

Before working with the internal components you will need to wear an anti-
static wrist strap to ground yourself because static electricity may damage the
components.

The chapter includes:

• Replacing the Battery
• Replacing the HDD
• Upgrading the System Memory
• Replacing the CD Device
Please make sure that you review each procedure before you perform it.

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.
Overview 6 - 1
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When Not to Upgrade
These procedures involve opening the system’s case, adding and sometimes
replacing parts.

You should not perform any of these upgrades if:

• Your system is still under warranty or a service contract
• You don’t have all the necessary equipment 
• You’re not in the correct environment
• You doubt your abilities

Under any of these conditions, contact your service representative to purchase
or replace the component(s).

Power Safety 
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines). It is
advisable to also re-
move your battery in
order to prevent acci-
dentally turning the
machine on.
- 2 Overview
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Removing the Battery
If you are confident in undertaking upgrade procedures yourself, for safety
reasons it is best to remove the battery. Under normal circumstances we rec-
ommend that you do not remove the battery.

Battery Removal Process
1. Turn the computer off, and turn it over.
2. Remove screws  &  from the battery cover, and remove the cover.
3. Carefully (use a small screwdriver) disconnect the battery cable at point .
4. Lift the battery out of the computer’s battery bay. 
5. Connect the battery cable before reinserting the battery.

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

1 2
3

1 2

3
Figure 6 - 1

Battery Removal
Removing the Battery 6 - 3



Upgrading The Computer

6

6

Upgrading the Hard Disk Drive
The hard disk drive can be taken out to accommodate other 2.5" IDE hard disk
drives with a height of 9.5mm (h) (see “Storage Devices” on page  A - 2). Fol-
low your operating system’s installation instructions, and install all necessary
drivers and utilities as outlined in “What to Install” on page 4 - 1, when set-
ting up a new hard disk. 

Hard Disk Upgrade Process
1. Turn off the computer, and turn it over.
2. Remove screws  -  from the hard disk cover, and remove the cover.
3. Disconnect the hard disk cable at point  by carefully, but firmly, gripping 

the plastic loop and easing it upwards.
4. Lift the HDD assembly out of the computer’s hard disk bay.

HDD System 
Warning

New HDD’s are blank.
Before you begin make
sure:
You have backed up any
data you want to keep
from your old HDD.
You have all the CD-
ROMs and FDDs re-
quired to install your oper-
ating system and
programs.
If you have access to the
internet, download the lat-
est application and hard-
ware driver updates for
the operating system you
plan to install. Copy these
to a removable medium.

Figure 6 - 2
HDD Assembly 

Removal

1 4
5

1 2

34

5
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5. Carefully disconnect the hard disk cable  from the rear of the hard disk 
assembly, and pay careful attention to which end of the cable connects to 
the hard disk (see sidebar). 

6. Remove screws  -  from the hard disk assembly.
7. Take the HDD out of the case, and pay careful attention to the orientation of 

the disk in the case.
8. Insert the new HDD into the case and replace screws  - .
9. Reconnect the HDD connector cable (see sidebar).
10. Reverse the removal procedure to install the new HDD assembly.

1

2 5

2 5

HDD Cable

The hard disk cable
connects to the hard
disk in one way only.
The letters HD on the
cable should be on the
side which connects to
the hard disk (not the
side which connects to
the computer’s main-
board).

Figure 6 - 3
HDD Case 
Screws & 

Connector Cable

1

2

3

4

5
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Upgrading the System Memory (RAM)
Model A, B & D computers have TWO memory sockets for 200 pins Small
Outline Dual In-line (SO-DIMM) type DDR SDRAM modules. Model C
computers have ONE memory socket for 200 pins Small Outline Dual In-
line (SO-DIMM) type DDR SDRAM modules.  All computers support DDR
200/ DDR 266/ DDR 333.

The main memory on Model A, B & D computers can be expanded up to
1024MB. The main memory on Model C computers can be expanded up to
512MB. The SO-DIMMs supported are 128MB, 256MB, and 512MB in size,
and the total memory size is automatically detected by the POST routine once
you turn on your computer. Check Table 1 - 1 on page 1 - 5 to check the mod-
el differences.

Pictures

The pictures used in
this chapter are of
Model A, B & D com-
puters with two memo-
ry sockets. Model C
computers have one
memory socket.
- 6 Upgrading the System Memory (RAM)
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Memory Upgrade Process
1. Turn the computer off, and turn it over.
2. Remove screws  -  from the memory socket cover.
3. Carefully lift up the memory socket cover (a fan cable is still attached to the 

mainboard and there is no need to disconnect it) and set it on the computer.
4. Remove any currently installed module(s), if it/they need to be upgraded or 

replaced.
Figure 6 - 4

Memory Socket Cover 
Removal

1 6

1

2

54

3 6
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5. Gently pull the two release latches (  &  in Figure 6 - 5) on the sides 
of the memory socket toward the sides of the computer.

6. The module  will pop-up, and you can remove it.
7. Repeat the process for the second module if necessary.
8. Insert a new module holding it at about a 30° angle and fit the connectors 

firmly into the memory slot.

1 2

1

12 3

Contact Warning

Be careful not to touch
the metal pins on the
module’s connecting
edge. Even the clean-
est hands have oils
which can attract parti-
cles, and degrade the
module’s perfor-
mance.

Figure 6 - 5
Removing/

Installing a RAM 
Module 3
- 8 Upgrading the System Memory (RAM)
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9. The module’s pin alignment will allow it to only fit one way. Make sure the 
module is seated as far into the slot as it will go. DO NOT FORCE the 
module; it should fit without much pressure.

10. Press the module in and down towards the mainboard until the slot levers 
click into place to secure the module.

11. Replace the memory socket cover (be careful with the fan cable) and the 6 
screws (see Figure 6 - 4).

12. Restart the computer.
13. The BIOS will register the new memory configuration as it starts up.

Figure 6 - 6
Memory Sockets One 

& Two
Upgrading the System Memory (RAM) 6 - 9
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Upgrading the CD Device
The easy changeable CD device may be upgraded or changed.

CD Device Upgrade Process
1. Turn the computer off, and turn it over.
2. Remove screws  -  from the memory socket cover.
3. Carefully lift up the memory socket cover (a fan cable is still attached to the 

mainboard and there is no need to disconnect it) and set it on the computer.

Figure 6 - 7
Memory Socket Cover 

Removal

1 6

1

2

54

3 6
- 10 Upgrading the CD Device



Upgrading The Computer

6

4. Use a screwdriver to carefully push the CD device assembly out of the 
computer at point .

5. Insert the new device and carefully slide it into the computer (the device only 
fits one way). DO NOT FORCE IT; the screw holes should line up.

6. Replace the memory socket cover (be careful with the fan cable) and the 6 
screws (see Figure 6 - 4).

7. Restart the computer to allow it to automatically detect the new device.

1

1

Figure 6 - 8
CD Device Removal
Upgrading the CD Device 6 - 11
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Upgrading the Processor
If you want to upgrade your computer by replacing the existing processor with
a faster/new one you will need to contact your customer service representa-
tive. We recommend that you do not do this yourself, since if it is done incor-
rectly you may damage the processor or mainboard.

Warranty

The CPU is not a user
serviceable part.
Opening this compart-
ment, or accessing the
CPU in any way, may
violate your warranty.
- 12 Upgrading the Processor



Optional Modules

7

Chapter 7: Optional Modules
Overview
This chapter contains the information on the various optional modules
which may come with your computer, depending on the configuration pur-
chased. If you are unsure please contact your service representative.

The chapter includes information on the following:

• The Wireless LAN & Bluetooth Modules
• The PC Camera

 Wireless Module ON/OFF Switch

While installing the drivers make sure that the Wireless Module ON/OFF
switch is turned OFF, until you come to install the drivers for the 802.11b Wireless
LAN or Bluetooth modules. Before installing the 802.11b Wireless LAN or Blue-
tooth drivers turn the switch ON. If you have both the 802.11b Wireless LAN and
Bluetooth modules, use the Fn + F12 key combination to toggle the power to the
module(s). If the Found New Hardware Wizard appears at any time (other than
when outlined in the driver install procedure), click Cancel.
Overview 7 - 1
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Wireless LAN & Bluetooth Modules
If your purchase includes the optional 802.11b Wireless LAN module and/or
Bluetooth module, make sure you install the supplied device driver(s) for it/
them as indicated in the following pages (only install the drivers for the op-
tional modules you have purchased). You will need to turn the module(s) on
by using the ON/OFF switch  at the front of the computer.

If you have both the Wireless LAN and Bluetooth modules in your com-
puter, you can use the key combination Fn + F12 to toggle the power to the
modules. The power status of the module will be indicated by the Mail LED
indicator . If you have installed the Auto Mail program, and mail is incom-
ing, then the mail notification warning will be shown (see “LED Power &
Communication Indicators” on page 2 - 6).

If you have both wireless modules, turning the ON/OFF switch  on will
turn on one of the Wireless modules. Use the Fn + F12 key combination to
toggle power to the other, or both, modules (see “LED Power & Communi-
cation Indicators” on page 2 - 6 for the power status).

If you have one wireless module it will be auto-detected, and you do not need
to use the Fn + F12 key combination.

Communication 
Conflict

Do not try to use the
802.11b Wireless LAN
module and the Blue-
tooth module at the
same time, as this may
cause a communica-
tion conflict.

Wireless Device 
Operation Aboard 

Aircraft

The use of any porta-
ble electronic trans-
mission devices
aboard aircraft is usu-
ally prohibited. Make
sure the modules are
OFF if you are using
the computer aboard
aircraft.
- 2 Wireless LAN & Bluetooth Modules
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Wireless LAN Driver Installation (Win2000)
1. Turn the Wireless Module ON/OFF switch ON.
2. If you only have the Wireless LAN module go straight to step 3. If you 

have two wireless modules, you may need to use the key combination Fn 
+ F12 to enable the Wireless LAN module (the Mail LED indicator  
will be green - see “LED Power & Communication Indicators” on 
page 2 - 6).

3. If the Found New Hardware Wizard appears, click Cancel.
4. Insert the Wireless LAN CD-ROM into the CD drive.
5. The program will run automatically.
6. Click Next > Next > Yes > Next > Next.
7. Click Yes if you wish to add a shortcut to the WLAN utility on the desk-

top.
8. Follow the instructions to install the Adobe Acrobat Reader (if you do 

not already have Adobe Acrobat Reader installed) and click Yes if asked 
if you want to continue.

9. Click OK > Finish then restart the computer.

The Wireless LAN User Manual is in Adobe .pdf format (Start menu and
point to Programs > IEEE 802.11b WLAN Utility(USB) > User Manual).

Network Protocols

During the install proc-
ess you may be asked
to install some network
protocols. To do this
go to the Network and
Dial-up Connections
control panel, and dou-
ble-click Local Area
Connection. Click In-
stall (button) and click
on Protocol (or any
Services or Clients
required) and Add
(button) to select the
protocols you require.
You will need to restart
the computer after in-
stalling some Proto-
cols/Services/
Clients.
Wireless LAN & Bluetooth Modules 7 - 3
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Wireless LAN Driver Installation (WinXP)
1. Turn the Wireless Module ON/OFF switch ON.
2. If you only have the Wireless LAN module go straight to step 3. If you 

have two wireless modules, you may need to use the key combination Fn 
+ F12 to enable the Wireless LAN module (the Mail LED indicator  
will be green - see “LED Power & Communication Indicators” on 
page 2 - 6).

3. If the Found New Hardware Wizard appears, click Cancel.
4. Insert the Wireless LAN CD-ROM into the CD drive.
5. The program will run automatically.
6. Click Next > Next > Yes > Next > Next.
7. Click Yes if you wish to add a shortcut to the WLAN utility on the desk-

top.
8. Follow the instructions to install the Adobe Acrobat Reader (if you do 

not already have Adobe Acrobat Reader installed) and click Continue 
Anyway if asked if you want to continue.

9. Click Finish and restart the computer.

The Wireless LAN User Manual is in Adobe .pdf format (Start menu and
point to Programs/All Programs > IEEE 802.11b WLAN Utility(USB)
then select the User Manual).
- 4 Wireless LAN & Bluetooth Modules
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Bluetooth Driver Installation (Win2000)
1. Turn the Wireless Module ON/OFF switch ON.
2. If you only have the Bluetooth module go straight to step 3. If you have 

two wireless modules, you may need to use the key combination Fn + 
F12 to enable the Bluetooth module (the Mail LED indicator  will be 
orange - see “LED Power & Communication Indicators” on page 2 - 
6).

3. If the Found New Hardware Wizard appears, click Cancel.
4. Insert the Bluetooth CD-ROM into the CD drive.
5. The program will run automatically.
6. If the Found New Hardware Wizard appears, click Cancel, and click OK 

if you see Unsafe Removal of Device. 
7. Click Start (menu) > Run...
8. Navigate (Browse...) to the top level of the CD D:\ and click OK.
9. Click Install Drivers and Application Software.
10. Click Next.
11. Click the button to accept the license agreement, then click Next.
12. Click Next > Install (click OK if asked if you want to continue).
13. Click Finish > Yes to restart the computer.
14. You can configure the settings in the Bluetooth Configuration control 

panel (Start menu and point to Settings and click Control Panel then 
double-click the Bluetooth Configuration icon).

The Bluetooth User’s guide (Manual) is on the Bluetooth CD-ROM in the
Userguide folder (click Browse this CD when you insert the Bluetooth CD-
ROM). It is in .html format.
Wireless LAN & Bluetooth Modules 7 - 5
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Bluetooth Driver Audio Setup (Win2000)
After installing the Bluetooth driver in Windows 2000 you may no longer hear
any sound, nor see the Volume icon in the taskbar. If this is the case then fol-
low this procedure:

1. Go to the Sounds & Multimedia Control Panel (Start Menu and point to 
Settings and click Control Panel then double-click the Sounds & Multime-
dia icon).

2. Click the Audio tab.
3. In the Sound Playback and Sound Recording menus choose Realtek 

AC97 Audio.
4. Click the Sounds tab and make sure that the tickbox to “Show volume 

control on the taskbar” is ticked.
5. Click OK.
- 6 Wireless LAN & Bluetooth Modules



Optional Modules

7

Bluetooth Driver Installation (WinXP)
1. Turn the Wireless Module ON/OFF switch ON.
2. If you only have the Bluetooth module go straight to step 3. If you have 

two wireless modules, you may need to use the key combination Fn + F12 
to enable the Bluetooth module (the Mail LED indicator  will be 
orange - see “LED Power & Communication Indicators” on page 2 - 6).

3. If the Found New Hardware Wizard appears, click Cancel.
4. Insert the Bluetooth CD-ROM into the CD drive.
5. The program will run automatically.
6. Click Install Drivers and Application Software and click Next.
7. Click the button to accept the license agreement, then click Next.
8. Click Next > Install (click OK if asked if you want to continue).
9. Click Finish and restart the computer.
10. When the Found New Hardware Wizard appears select “Install from a 

list or specific location (Advanced)” then click Next.
11. Select “Search for the best driver in these locations.” and select 

ONLY “Include this location in the search:”.
12. Navigate (Browse...) to the top level of the CD D:\ and click OK > Next 

> Finish (click Continue Anyway if asked if you want to continue), 
then restart the computer.

13. You can configure the settings in the Bluetooth Configuration control 
panel (Start menu and point to Settings and click Control Panel then 
double-click the Bluetooth Configuration icon).

The Bluetooth User’s guide (Manual) is on the Bluetooth CD-ROM in the
Userguide folder (click Browse this CD when you insert the Bluetooth CD-
ROM). It is in .html format.
Wireless LAN & Bluetooth Modules 7 - 7
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Control Panel Options (Bluetooth)
You may need to change some control panel options after installing the Blue-
tooth driver:

Audio
1. Go to the Start menu and point to Settings and click Control Panel, then 

double-click the Sounds & Audio Devices/Sounds & Multimedia icon 
(Category View > Speech, and Audio Devices).

2. Click Audio (tab) and make sure that the “Default device:” is the Realtek 
AC97 Audio.

Hyper Terminal
1. Go to Start menu and click Programs/All Programs, then point to Acces-

sories > Communications > HyperTerminal.
2. Double-Click your connection, and make sure you have selected “Connect 

Using:” 56K MDC Modem.

FAX (WinXP)
1. Go to the Start menu and point to Settings and click Control Panel, then 

double-click the Printers and Faxes icon (Category View > Printers and 
Other Hardware).

2. Double-click your fax icon to bring up the Fax Console.
3. Click the Tools menu and scroll down to “Configure Fax...”.
4. Click Next > Next and make sure that the fax device is the 56K MDC 

Modem.
- 8 Wireless LAN & Bluetooth Modules
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FAX (Win2000)
1. Go to the Start menu and point to Settings and click Control Panel, then 

double-click the Fax icon.
2. Click Advanced Options (tab) and click the Open Fax Service 

Management Console (button).
3. Click Devices in the Tree window on the left.
4. The fax devices will be displayed in the right window, with the device with 

the highest priority displayed at the top.
5. Select the 56K MDC Modem and use the arrows to move it to the top of the 

priority list, then close the windows.
Wireless LAN & Bluetooth Modules 7 - 9
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PC Camera
If you have purchased the optional PC Camera you will need to install the de-
vice driver for it as indicated in the following pages (only install the drivers
for the optional modules you have purchased). After installing the driver
you can run the application software by going to the CMM PC Camera item
in the Start > All Programs/Programs menu and selecting the AMCAP pro-
gram.

Taking Still Pictures

You may take still pic-
tures in the Windows
XP operating system
only.

Double-click the My
Computer icon on the
desktop, or go the
Start menu and point
to My Computer, then
click it.

.Double-click the CMM
PC Camera icon.

 

Click Take a new pic-
ture in the Camera
Tasks box.
- 10 PC Camera
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PC Camera Driver Installation (Win2000)
1. Insert the PC Camera CD-ROM into the CD Drive.
2. The program will run automatically (or click Start (menu) > Run... and 

navigate (Browse...) to D:\Setup.exe and click OK).
3. Click Next (click Yes if asked if you want to continue at any time).
4. Click Finish to restart the computer.
5. To run the application software go to the CMM PC Camera item in the 

Start > Programs menu, and select the AMCAP program (see 
“AMCAP” on page 7 - 15).
PC Camera 7 - 11
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PC Camera Driver Installation (WinXP)
1. Insert the PC Camera CD-ROM into the CD Drive.
2. The program will run automatically (or click Start (menu) > Run... and 

navigate (Browse...) to D:\Setup.exe and click OK).
3. Click Next to continue.
4. Click Finish to restart the computer.
5. To run the application software go to the CMM PC Camera item in the 

Start > Programs/All Programs menu, and select the AMCAP pro-
gram (see “AMCAP” on page 7 - 15).
- 12 PC Camera
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Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup
the audio recording options in Windows. To do this in Windows XP (for Win-
dows 2000 see sidebar):

1. Go to the Start menu and point to Settings and click Control Panel, then 
double-click the Sounds & Audio Devices icon (Category View > Speech, 
and Audio Devices).

2. Click Advanced in the Volume tab.
3. Click Options (Volume Control) and scroll down and click Properties.
4. Click Recording (Adjust volume for) and click Microphone (check box), 

then click OK.
5. Make sure the Select (check box) in the Recording Control panel, under 

the Microphone section, is checked (boost the volume as high as it will go).
6. Close the open windows.

Windows 2000 Audio 
Setup

Go to the Start menu
and point to Settings
and click Control Pan-
el then double-click the
Sounds and Multime-
dia icon.

Click Audio (tab) and
click Volume (button)
in the Sound Record-
ing menu.

Select Advanced
Controls from the Op-
tions menu.

(Continued overleaf.)
PC Camera 7 - 13
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Windows 2000 Audio 
Setup (continued)

Make sure the Select
(check box) in the Mi-
crophone section is
checked, and boost
the volume as high as
it will go.

Close the windows.

Figure 7 - 1
Audio Setup 

(Windows XP)
- 14 PC Camera
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AMCAP
AMCAP is a video viewer useful for general purpose video viewing and test-
ing, and can capture video files to .avi format.
To capture video:
 

1. Run the AMCAP program from the Start > Programs menu (it is recom-
mended that you set the capture file before the capture process - see Set 
Capture File below).

2. Go to the Capture menu heading (if you wish to capture audio make sure 
that the Capture Audio option is ticked) and select Start Capture.

3. On the first run of the program (if you have not set the captured file) you will 
be asked to choose a file name and size (see the sidebar - Pre-Allocating 
File Space) for the captured file. Click Start Capture again.

4. Click OK to start capturing the video, and press Esc to stop the capture.
5. If you wish to, you may go to the File menu and select Save Captured 

Video As..., choose a file name and location, then click Open (you can view 
the file using the Windows Media Player).

Set Capture File
In the AMCAP program, you will only be asked to set the capture file name
on the first run of the program. When you run the program the next time the
file will automatically be overwritten with the newly captured file. To avoid
overwriting files you can go to the Set Capture File.. option in the File menu,
and set the file name and location before capture. Set the name and location,
then click Open (you can choose Cancel to ignore the file size if prompted).

Pre-Allocating File 
Space

You may pre-allocate
the file size for the cap-
ture file in the AMCAP
program. You can
choose to ignore this
by clicking Cancel.

Pre-allocating space
on the hard disk can
improve the capture
quality (particularly of
large capture files), by
reducing the amount of
work the hard disk has
to do in finding space
for the video data as it
is being captured.

You may find it helpful
to defragment the HDD
before capture.
PC Camera 7 - 15
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Eliminating Screen Flicker
If you find that the video screen in the AMCAP program is flickering, you can
try to adjust the option from the Video Capture Filter options.
1. Run the AMCAP program from the Start > Programs menu.
2. Go to Options and scroll down to select “Video Capture Filter...”.
3. You can choose either 50Hz or 60Hz from the No Flicker box.

Figure 7 - 2
Camera Controls
- 16 PC Camera
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Chapter 8: Troubleshooting
Overview
Should you have any problems with your computer, before consulting your service representative, you
may want to try to solve the problem yourself. This chapter lists some common problems and their possible
solutions. This can’t anticipate every problem, but you should check here before you panic. If you don’t
find the answer in these pages, make sure you have followed the instructions carefully and observed the
safety precautions in the preface. If all else fails, talk to your service representative. You should also make
a record of what happened and what remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should
preview this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try
turning it off for a few minutes and then rebooting. You will lose any unsaved data, but it may start work-
ing again. Then call your service representative.
Overview 8 - 1
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Basic Hints and Tips
Many of the following may seem obvious but they are often the solution to a problem when your computer
appears not to be working. 

• Power - Is the computer actually plugged into a working electrical outlet? If plugged into a 
power strip, make sure it is actually working. Check the LED Power Indicators (see “LED 
Power & Communication Indicators” on page 2 - 6) to see the computer’s power status.

• Connections - Check all the cables to make sure that there are no loose connections anywhere.

• Power Savings - Make sure that the system is not in Hibernate or Standby mode by pressing the 
Fn + F4 key combination (see “System Resume” on page 3 - 24), or by pressing the power but-
ton, to wake-up the system.

• Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust 
the brightness (see “Advanced Video Controls” on page 3 - 2).

• Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display (see 
“Switching/Enabling Displays (Keyboard)” on page 3 - 10).

• Boot Drive - Make sure there are no floppy disks in the drive when you start up your machine 
(this is a common cause of the message “Invalid system disk - Replace the disk, and then press 
any key” / “Remove disks or other media. Press any key to restart”).
- 2 Basic Hints and Tips
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Backup and General Maintenance
• Always backup your important data, and keep copies of your OS and programs safe, but close to 

hand. Don’t forget to note the serial numbers if you are storing them out of their original cases, 
e.g. in a CD wallet.

• Run maintenance programs on your hard disk and OS as often as you can. You may schedule 
these programs to run at times when you are not using your computer. You can use those that are 
provided free with your OS, or buy the more powerful dedicated programs to do so.

• Write down your passwords and keep them safe (away from your computer). This is especially 
important if you choose to use a Startup password for the BIOS (see “Security Menu” on page 5 
- 14).

• Keep copies of vital settings files such as network, dialup settings, mail settings etc. (even if just 
brief notes).

Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate
your warranty.
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Viruses
• Install an Anti-Virus program and keep the definitions file (the file which tells your program 

which viruses to look for) up to date. New computer viruses are discovered daily, and some of 
them may seriously harm your computer and cause you to lose data. Anti-Virus programs are 
commercially available and the definitions file updates are usually downloadable directly from 
the internet.

• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from 
within e-mail attachments so take care when opening any attached file. You can configure most 
Anti-Virus programs to check all e-mail attachments. Note: You should also beware of files 
from people you know as the virus may have infected an address book and been automatically 
forwarded without the person’s knowledge.

• Keep a “Boot Floppy Disk” (this disk provides basic information which allows you to startup 
your computer) handy. You may refer to your OS’s documentation for instructions on how to 
make one, and many Anti-Virus programs will also provide such a disk (or at least instructions 
on how to make one).
- 4 Viruses
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Upgrading and Adding New Hardware/Software
• Do not be tempted to make changes to your Windows Registry unless you are very sure of what 

you are doing, otherwise you will risk severely damaging your system.

• Don’t open your computer or undertake any repair or upgrade work if you are not comfortable 
with what you are doing.

• Read the documentation. We can assume, since you are reading this that you are looking at the 
computer’s manual, but what about any new peripheral devices you have just purchased? Many 
problems are caused by the installation of new hardware and/or software. Always refer to the doc-
umentation of any new hardware and/or software, and pay particular attention to files entitled 
“READ ME” or “READ ME FIRST”.

• When installing a new device always make sure the device is powered on, and in many cases you 
will need to restart the computer. Always check that all the cables are correctly connected.

• Make sure you have installed the drivers for any new hardware you have installed (latest driver 
files are usually available to download from vendor’s websites).
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• Thoroughly check any recent changes you made to your system as these changes may affect one 
or more system components, or software programs. If possible, go back and undo the change you 
just made and see if the problem still occurs.

• Don’t over complicate things. The less you have to deal with then the easier the source of the 
problem may be found; Example - if your computer has many devices plugged into its ports, and 
a number of programs running, then it will be difficult to determine the cause of a problem. Try 
disconnecting all of the devices and restarting the computer with all the peripheral devices 
unplugged. A process of elimination (adding and removing devices and restarting where neces-
sary) will often find the source of a problem, although this may be time consuming.
- 6 Upgrading and Adding New Hardware/Software
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Power

Problem Possible Cause - Solution

You turned on the power 
but it doesn’t work.

Battery missing / incorrectly installed. Check the battery bay, make sure the battery is 
present and seated properly (the design of the battery only allows it to go in one way). 
Make sure there’s nothing interfering with the battery contacts.

The Battery LED power 
indicator , is blinking 
orange.

Low Battery. Plug in the AC power source. If the computer doesn’t start up immediately, 
turn it off then on again.

You are losing battery 
power too quickly.

The system is using too much power. If your OS has a Power Options scheme (see 
“Conserving Power (Individual Components)” on page 3 - 22) check its settings. You 
may also be using a PC Card device that is drawing a lot of power.

The notebook feels too 
hot.

Make sure the computer is properly ventilated and the vents/fan intakes are not blocked 
(see “Overheating” on page 1 - 18). If this doesn’t cool it down, put the system into 
Hibernate mode or turn it off for an hour. Make sure the computer isn’t sitting on a thermal 
surface. Make sure you’re using the correct adapter. 

Make sure that your computer is completely powered off before putting it into a travel bag 
(or any such container).
Power 8 - 7
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Actual battery operating 
time is shorter than 
expected.

The battery has not been fully discharged before being recharged. Make sure the battery 
is fully discharged and recharge it completely before reusing (see “Battery Information” 
on page 3 - 26).

Power Options have been disabled. Go to the Control Panel in Windows and re-enable 
the options.

A peripheral device or PC Card is consuming a lot of power. Turn off the unused device to 
save power.

Problem Possible Cause - Solution
- 8 Power
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Display

Problem Possible Cause - Solution

Nothing appears on 
screen.

The screen saver is activated. Press any key or touch the TouchPad.

The system is in a power saving mode. Toggle the sleep/resume key combination, Fn + F4 
(see “Function Keys and Numeric Keypad” on page 2 - 19).

The screen controls need to be adjusted. Toggle the screen control key combinations Fn + 
F8/F9 (see “Opening the LCD” on page 3 - 2). If you’re connected to an external monitor, 
make sure it’s plugged in and turned on. You should also check the monitor’s own 
brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key combination, Fn 
+ F7 (see “Switching/Enabling Displays (Keyboard)” on page 3 - 10). If an external 
monitor is connected, turn it on.

No image appears on the 
external monitor I have 
plugged in and powered 
on.

You haven’t used the key combination to switch the display options. Press the Fn + F7  
key combination to toggle through the options.

You haven’t installed the video driver and configured it appropriately from the Control 
Panel. See “What to Install” on page 4 - 1 for instructions on installing the driver, and 
see “Video Driver Controls” on page 3 - 3 for instructions on configuring the video 
driver.
Display 8 - 9
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Boot Password

Problem Possible Cause - Solution

You forget the boot 
password.

If you forget the password, you may have to discharge the battery of the CMOS. Contact 
your service representative for help.

Password Warning
If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
- 10 Boot Password
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Floppy Disk Drive

Problem Possible Cause - Solution

The floppy disk drive will 
not write data to disk.

The floppy disk is not formatted. Format the disk (you may do this by right-clicking the disk 
icon in My Computer in Windows and choosing Format from the menu). Bear in mind that 
this will erase all data contained on the floppy disk.

Note: Floppy disks were never intended for long-term data storage, and have a finite life 
span. Do not store important files you wish to keep for a long time on floppy disks. As a 
general rule it is worth reformatting floppy disks regularly.

The floppy disk is write-protected. Undo the protection by moving the write-protect tab on 
the disk down until it clicks.

There is not enough unused space available on the disk. Use a new disk or delete any 
unneeded data.

The message “Invalid 
system disk - Replace 
the disk, and then 
press any key”/ 
“Remove disks or other 
media. Press any key 
to restart” appears.

The computer is trying to boot from an incorrect floppy disk. Remove the floppy and insert 
a correct one, or boot from your hard disk or CD. You will need to restart the computer.

Model Differences

Only Model C computers do not have floppy disk drives (see “Model Differences” on
page 1 - 5).
Floppy Disk Drive 8 - 11
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Audio

Problem Possible Cause - Solution

The sound cannot be 
heard or the volume is 
very low.

The volume might be set too low. Check the volume control in the Volume Control Panel 
in the Windows taskbar, or use the key combination Fn + F5 and F6 (see “Function Keys 
and Numeric Keypad” on page 2 - 19) to adjust.

Bluetooth Driver & Audio Setup in Windows 2000

After installing the Bluetooth driver in Windows 2000 you may no longer hear any sound, nor see the Volume icon
in the taskbar. If this is the case then follow this procedure:

1. Go to the Sounds & Multimedia Control Panel (Start Menu and point to Settings and click Control Panel then
double-click the Sounds & Multimedia icon).

2. Click the Audio tab.
3. In the Sound Playback and Sound Recording menus choose Realtek AC97 Audio.
4. Click the Sounds tab and make sure that the tickbox to “Show volume control on the taskbar” is ticked.
5. Click OK.
- 12 Audio
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CD Device

Problem Possible Cause - Solution

The compact disc cannot 
be read.

The compact disc is dirty. Clean it with a CD-ROM cleaner kit.

The compact disc tray 
will not open when there 
is a disc in the tray.

The compact disc is not correctly placed in the tray. Gently try to remove the disc using the 
eject hole (see “Loading Discs” on page 2 - 12).

The DVD regional codes 
can no longer be 
changed.

The code has been changed the maximum 5 times. See “DVD Regional Codes” on 
page 2 - 14.

A music compact disc 
can be read while a data 
disc can not.

There may be a problem with the disc hardware or software. Refer to your operating 
system manual for more information on the software and make sure you have the correct 
software installed for running video compact discs. If the proper software is installed and a 
problem still exists, contact your service center about a possible hardware problem.
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PC Card

Problem Possible Cause - Solution

The system cannot 
recognize the PC Card.

The PC Card is not inserted into the socket or inserted incorrectly. Remove the card and 
re-insert it aligning the PC Card with the slot. Push the card in until it locks into place.

The PC Card or card driver is not compatible with the computer. Check “PC Card” on 
page  A - 2 to check the compatibility of the card.

The PC Card driver is not installed. Install the driver (see “What to Install” on page 4 - 1).

The system cannot access the card after it is installed. Please read the documentation 
which comes with any new external device. Make sure you install any drivers, if they are 
supplied with it, as this will allow you to access any extra functions which come with the 
device.

Model Differences

Only Model C computers do not have a PC Card slot (see “Model Differences” on page 1 - 5).
- 14 PC Card
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Keyboard

Problem Possible Cause - Solution

Unwelcome numbers 
appear when typing.

If the LED  is lit, then Number Lock is turned ON. Press and release the Fn + NumLk 
key combination.

Other Keyboards
If your keyboard is damaged or you just want to make a change, you can use any standard PS/2 or USB keyboard.
The system will detect and enable it automatically. However special functions/hot keys unique to the system’s reg-
ular keyboard may not work.
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Operation
Problem Possible Cause - Solution

The system freezes or 
the screen goes dark.

The system’s power saving features have timed-out. Use the AC adapter, press the sleep 
(Fn + F4) key combination, or press the power button (see “Configuring the Power 
Button” on page 3 - 25). 

The system never goes 
into Hibernate mode.

Make sure you have enabled Hibernate in the Power Options control panel in your OS 
(see “Hibernate” on page 3 - 24).

The system does not go 
into a power saving 
mode when the battery is 
low.

No power saving options are enabled. Use one of the Power Options presets.

The infrared device does
not work (Model C com-
puters do not have an in-
frared transceiver - see
“Model Differences” on
page 1 - 5).

The drivers (if supplied with the device) are not loaded. Read the documentation which 
comes with any new external device. Make sure you install the driver (if one is required) 
for it as this will allow you to access any extra functions which come with your device.

The FIR settings are not configured correctly. See “Configuring the Infrared Settings for 
FIR” on page 3 - 28. Check the settings for the infrared device in the BIOS (see “I/O 
Device Configuration (Advanced Menu)” on page 5 - 13) are for the FIR setting.

The infrared transceiver is blocked. Make sure nothing is between your system’s infrared 
transceiver and the destination’s transceiver. Infrared transceivers operate on a “Line 
of’Sight”.
- 16 Operation
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Wireless LAN & Bluetooth Modules
Problem Possible Cause - Solution

The Wireless LAN or 
Bluetooth module cannot 
be detected.

The ON/OFF switch  has not been switched ON. Make sure you have set the ON/OFF 
switch to ON in order to enable the module (see “Wireless LAN & Bluetooth Modules” 
on page 7 - 2). 

The ON/OFF switch  has been switched ON, but you have both the Wireless LAN and 
Bluetooth modules in your computer. Use the Fn + F12 key combination to toggle power to 
the modules. DO NOT enable power and attempt to use both modules at the same time as 
this may cause a conflict.

The Wireless LAN or 
Bluetooth module cannot 
be configured.

The driver(s) for the module(s) have not been installed. Make sure you have installed the 
driver for the appropriate module (see “Wireless LAN & Bluetooth Modules” on page 7 
- 2).

Both modules come with User Guides/Manuals to help you configure them:

The Wireless LAN User Manual is in Adobe .pdf format (Start menu and point to 
Programs > IEEE 802.11b WLAN Utility(USB) > User Manual).
The Bluetooth User’s Guide (Manual) is on the Bluetooth CD-ROM in the Userguide 
folder (click Browse this CD when you insert the Bluetooth CD-ROM). It is in .html 
format.
Wireless LAN & Bluetooth Modules 8 - 17
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Driver Installation
Problem Possible Cause - Solution

There is a problem 
installing the Audio 
drivers in Windows XP.

You have enabled Windows XP Multi Language Options. Make sure that you do not 
enable any Multi Language Options when installing the drivers in Windows XP. 

Make sure you install the drivers in the order indicated in “What to Install” on page 4 - 1.
- 18 Driver Installation
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Hyper-Threading Notes
You can enable (the default setting is disabled) Hyper-Threading from the Advanced Menu in the BIOS
(see “Hyper-Threading (Advanced Menu) - Model D only” on page 5 - 11 and “Processor” on page D
- 1). Hyper-Threading is only supported in computers with a processor with Hyper-Threading Tech-
nology. If you do not have a processor with Hyper-Threading Technology, this menu option will not
appear.

Hyper-Threading is only supported in Windows XP, so DO NOT enable this option if you are using
Windows 2000. 

If you have updated the Flash ROM BIOS from a previous version, which did not have the Hyper-
Threading option, you must reinstall Windows XP after the BIOS update.

Once you have enabled Hyper-Threading, DO NOT disable the option or the computer may not startup
(returning to the BIOS and enabling the option will correct this in case of accidental disabling of the op-
tion).

If you are changing the processor from a CPU which supports Hyper-Threading, to one which does not,
you will need to reinstall your OS.
Hyper-Threading Notes 8 - 19



Troubleshooting

8

8

- 20



A

Appendix A: Model A Specifications
Processor
• Intel Pentium 4 Processor - (478-pin)  FC-PGA2 

package

(µ0.13) 0.13 Micron Process Technology, 512KB 
L2 Cache & 400MHz FSB - 2.0/ 2.2/ 2.4/ 2.5/ 2.6 
GHz

(µ0.13) 0.13 Micron Process Technology, 512KB 
L2 Cache & 533MHz FSB - 2.26/ 2.4/ 2.53/ 2.66/ 
2.8 GHz

• Intel Celeron Processor - (478-pin) FC-PGA2 
package

(µ0.18) 0.18 Micron Process Technology, 128KB
L2 Cache & 400MHz FSB - 1.7/ 1.8 GHz

(µ0.13) 0.13 Micron Process Technology, 128KB 
L2 Cache & 400MHz FSB - 2.0/ 2.1/ 2.2 GHz

Core Logic
• SIS M650 + 962 

Structure
• PC99 compliant

Security
• Security (Kensington® Type) Lock Slot
• BIOS Password

Memory
• Two 200-pins DDR SODIMM sockets, support-

ing DDR SDRAM SODIMM (2.5V) - DDR 200/ 
DDR 266/ DDR 333 compliant

• Memory expandable up to 1024MB (128/256/
512MB SODIMM Modules)

BIOS
• One 512KB Flash ROM
• Phoenix BIOS
A - 1
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LCD Options
• 14.1" XGA TFT (1024*768)
• 15.0" XGA TFT (1024*768)
• 15.0" SXGA+ TFT (1400*1050)

Display
• High Performance 256-bit 3D engine

Advanced HW accelerator for DVD playback
Fully DirectX 8.0 compliant graphics engine

• Dual-View display monitor

Audio
• AC'97 2.1 compliant interface 
• 3D stereo enhanced sound system
• Compatible with Sound-Blaster PRO™ 
• S/PDIF Digital output (5.1 CH) for DVD content 

and stereo audio
• Microphone-in jack
• Headphone-out jack
• Built-in microphone 
• 2 built-in speakers

Storage Devices
• 3.5" 3-mode Floppy Disk Drive

• Easy changeable 2.5" 9.5 mm (h) Hard Disk 
Drive 
Supports Master mode IDE
Supports PIO mode 4, ATA-33/66/100/133, Ultra 
DMA

• 12.7mm(h) Device Bay for ONE of the 
following drive configuration options:
CD-ROM
DVD-ROM
CD-RW
Combination CD-RW/DVD-ROM
DVD-RW

Keyboard
• “Win Key” keyboard

PC Card
• One Type II PCMCIA 3.3V/5V socket support-

ing CardBus
 - 2
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Pointing Device
• Built-in TouchPad (scrolling key functionality 

integrated) 

Interface
• Three USB 2.0 ports
• One Mini-IEEE 1394 port
• One S-Video Out port for TV output
• One serial port
• One parallel port (LPT1), supporting ECP / EPP
• One infrared transceiver supporting IrDA 1.1/

FIR/SIR/ASKIR
• One external CRT monitor port
• One external keyboard/mouse (through Y cable) 

PS/2 port
• One speaker-out/headphone-out jack
• One microphone-in jack
• One RJ-11 jack for Modem
• One RJ-45 jack for 100M/10M LAN
• One S/PDIF Out port
• One DC-in jack

Communication
• Wireless Infrared transfer IrDA 1.1 compliant, 

1cm - 1M operating distance, 115.2K bps SIR/ 
4Mbps FIR

• 10/100Mb Ethernet LAN built-in
• 56K MDC modem V.90 & V.92 compliant
• 802.11b wireless LAN module (available as a 

factory option)
• Bluetooth module (available as a factory option)
• PC Camera module (available as a factory 

option)

Power Management
• Supports ACPI v1.0b
• Supports suspend to RAM (S3)
• Supports suspend to disk (S4)
• Supports Battery low suspend
• Supports resume from modem ring
A - 3
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Power
• Full range AC adapter

AC Input: 100~240V, 50~60Hz
DC Output: 20V, 5A

• Supports one removable Smart Li-Ion battery

Indicators
• LED indicators (HDD, Power On/ AC-In/ Sus-

pend, Battery Charging/Battery Full, Num Lock, 
Caps Lock, Scroll Lock)

Environmental Spec
• Temperature

Operating: 5°C ~ 35°C
Non-Operating: -20°C ~ 60°C

• Relative Humidity
Operating: 20% ~ 80%
Non-Operating: 10% ~ 90%

Physical Dimensions
• 329 (w) x 275 (d) x 36.5 (h) mm

Weight
• Around 2.8 kg (depend on optional modules 

included) without battery 

Optional
• DVD-ROM Drive
• CD-RW Drive
• Combination Drive
• Software DVD player
• Wireless LAN module
• Bluetooth module
• PC Camera module
• DVD-RW Drive
 - 4
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Appendix B: Model B Specifications
Processor
• Mobile Intel Pentium 4 Processor - M (478-pin) 

Micro FCPGA package 

(µ0.13) 0.13 Micron Process Technology, 512KB 
L2 Cache & 400MHz FSB - 1.7/ 1.8/ 1.9/ 2.0/ 2.2/ 
2.4 GHz

• Mobile Intel Celeron Processor - (478-pin) 
Micro FCPGA package

(µ0.13) 0.13 Micron Process Technology, 256KB 
L2 Cache & 400MHz FSB - 1.6/ 1.7/ 1.8/ 2.0 GHz

Core Logic
• SIS M650 + 962 

Structure
• PC99 compliant

Security
• Security (Kensington® Type) Lock Slot
• BIOS Password

Memory
• Two 200-pins DDR SODIMM sockets, support-

ing DDR SDRAM SODIMM (2.5V) - DDR 200/ 
DDR 266/ DDR 333 compliant

• Memory expandable up to 1024MB (128/256/
512MB SODIMM Modules)

BIOS
• One 512KB Flash ROM
• Phoenix BIOS

LCD Options
• 14.1" XGA TFT (1024*768)
• 15.0" XGA TFT (1024*768)
• 15.0" SXGA+ TFT (1400*1050)
B - 1
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Display
• High Performance 256-bit 3D engine

Advanced HW accelerator for DVD playback
Fully DirectX 8.0 compliant graphics engine

• Dual-View display monitor

Audio
• AC'97 2.1 compliant interface 
• 3D stereo enhanced sound system
• Compatible with Sound-Blaster PRO™ 
• S/PDIF Digital output (5.1 CH) for DVD content 

and stereo audio
• Microphone-in jack
• Headphone-out jack
• Built-in microphone 
• 2 built-in speakers

Storage Devices
• 3.5" 3-mode Floppy Disk Drive 

• Easy changeable 2.5" 9.5 mm (h) Hard Disk 
Drive 
Supports Master mode IDE
Supports PIO mode 4, ATA-33/66/100/133, Ultra 
DMA

• 12.7mm(h) Device Bay for ONE of the 
following drive configuration options:
CD-ROM
DVD-ROM
CD-RW
Combination CD-RW/DVD-ROM
DVD-RW

Keyboard
• “Win Key” keyboard

PC Card
• One Type II PCMCIA 3.3V/5V socket support-

ing CardBus
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Pointing Device
• Built-in TouchPad (scrolling key functionality 

integrated) 

Interface
• Three USB 2.0 ports
• One Mini-IEEE 1394 port 
• One S-Video Out port for TV output
• One serial port
• One parallel port (LPT1), supporting ECP / EPP
• One infrared transceiver supporting IrDA 1.1/

FIR/SIR/ASKIR
• One external CRT monitor port
• One external keyboard/mouse (through Y cable) 

PS/2 port
• One speaker-out/headphone-out jack
• One microphone-in jack
• One RJ-11 jack for modem
• One RJ-45 jack for 100M/10M LAN
• One S/PDIF Out port
• One DC-in jack
• Built-in 3 instant keys: WWW, email, and appli-

cation

Communication
• Wireless Infrared transfer IrDA 1.1 compliant, 

1cm - 1M operating distance, 115.2K bps SIR/ 
4Mbps FIR

• 10/100Mb Ethernet LAN built-in
• 56K MDC modem V.90 & V.92 compliant
• 802.11b wireless LAN module (available as a 

factory option)
• Bluetooth module (available as a factory option)
• PC Camera module (available as a factory 

option)

Power Management
• Supports ACPI v1.0b
• Supports suspend to RAM (S3)
• Supports suspend to disk (S4)
• Supports Battery low suspend
• Supports resume from modem ring
B - 3



B

B

Power
• Full range AC adapter

AC Input: 100~240V, 50~60Hz
DC Output: 20V, 3.25A

• Supports one removable Smart Li-Ion battery 

Indicators
• LED indicators (HDD, Power On/ AC-In/ Sus-

pend, Battery Charging/Battery Full, Num Lock, 
Caps Lock, Scroll Lock)

Environmental Spec
• Temperature

Operating: 5°C ~ 35°C
Non-Operating: -20°C ~ 60°C

• Relative Humidity
Operating: 20% ~ 80%
Non-Operating: 10% ~ 90%

Physical Dimensions
• 329 (w) x 275 (d) x 36.5 (h) mm

Weight
• Around 2.8 kg (depend on optional modules 

included) without battery 

Optional
• DVD-ROM Drive
• CD-RW Drive
• Combination Drive
• Software DVD player
• Wireless LAN module
• Bluetooth module
• PC Camera module
• DVD-RW Drive
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Appendix C: Model C Specifications
Processor
• Intel Pentium 4 Processor - (478-pin) FC-PGA2 

package

(µ0.13) 0.13 Micron Process Technology, 512KB 
L2 Cache & 400MHz FSB - 2.0/ 2.2/ 2.4/ 2.5/ 2.6 
GHz

(µ0.13) 0.13 Micron Process Technology, 512KB 
L2 Cache & 533MHz FSB - 2.26/ 2.4/ 2.53/ 2.66/ 
2.8 GHz

• Intel Celeron Processor - (478-pin) FC-PGA2 
package

(µ0.18) 0.18 Micron Process Technology, 128KB
L2 Cache & 400MHz FSB - 1.7/ 1.8 GHz

(µ0.13) 0.13 Micron Process Technology, 128KB 
L2 Cache & 400MHz FSB - 2.0/ 2.1/ 2.2 GHz

Core Logic
• SIS M650 + 962 

Structure
• PC99 compliant

Security
• Security (Kensington® Type) Lock Slot
• BIOS Password

Memory
• One 200-pin DDR SODIMM socket, supporting 

DDR SDRAM SODIMM (2.5V) - DDR 200/ 
DDR 266/ DDR 333 compliant

• Memory expandable up to 512MB (128/256/
512MB SODIMM Module)

BIOS
• One 512KB Flash ROM
• Phoenix BIOS
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LCD Options
• 14.1" XGA TFT (1024*768)
• 15.0" XGA TFT (1024*768)
• 15.0" SXGA+ TFT (1400*1050)

Display
• High Performance 256-bit 3D engine

Advanced HW accelerator for DVD playback
Fully DirectX 8.0 compliant graphics engine

Audio
• AC'97 2.1 compliant interface 
• 3D stereo enhanced sound system
• Compatible with Sound-Blaster PRO™ 
• S/PDIF Digital output (5.1 CH) for DVD content 

and stereo audio
• Microphone-in jack
• Headphone-out jack
• Built-in microphone 
• 2 built-in speakers

Storage Devices
• Easy changeable 2.5" 9.5 mm (h) Hard Disk 

Drive 
Supports Master mode IDE
Supports PIO mode 4, ATA-33/66/100/133, Ultra 
DMA

• 12.7mm(h) Device Bay for ONE of the 
following drive configuration options:
CD-ROM
DVD-ROM
CD-RW
Combination CD-RW/DVD-ROM
DVD-RW

Keyboard
• “Win Key” keyboard

Pointing Device
• Built-in TouchPad (scrolling key functionality 

integrated) 
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Interface
• Three USB 2.0/ 1.1 ports
• One S-Video Out port for TV output
• One serial port
• One parallel port (LPT1), supporting ECP / EPP
• One external CRT monitor port
• One external keyboard/mouse (through Y cable) 

PS/2 port
• One speaker-out/headphone-out jack
• One microphone-in jack
• One RJ-11 jack for modem
• One RJ-45 jack for 100M/10M LAN
• One S/PDIF Out port
• One DC-in jack
• Wireless module On/Off switch
• Built-in 3 instant keys: WWW, email, and appli-

cation

Communication
• 10/100Mb Ethernet LAN built-in
• 56K MDC modem V.90 & V.92 compliant
• 802.11b wireless LAN module (available as a 

factory option)
• Bluetooth module (available as a factory option)
• PC Camera module (available as a factory 

option)

Power Management
• Supports ACPI v1.0b
• Supports suspend to RAM (S3)
• Supports suspend to disk (S4)
• Supports Battery low suspend
• Supports resume from modem ring

Power
• Full range AC adapter

AC Input: 100~240V, 50~60Hz
DC Output: 20V, 5A

• Supports one removable Smart Li-Ion battery 
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Indicators
• LED indicators (HDD, Power On/ AC-In/ Sus-

pend, Battery Charging/Battery Full, Num Lock, 
Caps Lock, Scroll Lock)

Environmental Spec
• Temperature

Operating: 5°C ~ 35°C
Non-Operating: -20°C ~ 60°C

• Relative Humidity
Operating: 20% ~ 80%
Non-Operating: 10% ~ 90%

Physical Dimensions
• 329 (w) x 275 (d) x 36.5 (h) mm

Weight
• Around 2.8 kg (depend on optional modules 

included) without battery 

Optional
• DVD-ROM Drive
• CD-RW Drive
• Combination Drive
• Software DVD player
• Wireless LAN module
• Bluetooth module
• PC Camera module
• DVD-RW Drive
 - 4



D

Appendix D: Model D Specifications
Processor
• Intel Pentium 4 Processor - (478-pin) FC-PGA2 

package
(µ0.13) 0.13 Micron Process Technology, 512KB 
L2 Cache & 400MHz FSB - 2.0/ 2.2/ 2.4/ 2.5/ 2.6 
GHz
(µ0.13) 0.13 Micron Process Technology, 512KB 
L2 Cache & 533MHz FSB - 2.26/ 2.4/ 2.53/ 2.66/ 
2.8/ 3.06* GHz

* Only Pentium 4 processors of 3.06GHz support 
Hyper-Threading Technology

• Intel Celeron Processor - (478-pin) FC-PGA2 
package
(µ0.18) 0.18 Micron Process Technology, 128KB
L2 Cache & 400MHz FSB - 1.7/ 1.8 GHz
(µ0.13) 0.13 Micron Process Technology, 128KB
L2 Cache & 400MHz FSB - 2.0 ~ 2.6 GHz

• Mobile Intel Pentium 4 Processor (Portability) - 
(478-pin) FC-PGA2 package

(µ0.13) 0.13 Micron Process Technology, 512KB 
L2 Cache & 533MHz FSB - 2.26/ 2.4/ 2.66/ 2.8/ 
3.06 GHz
(µ0.13) 0.13 Micron Process Technology, 512KB 
L2 Cache & 533MHz FSB with Hyper-Thread-
ing Technology - 2.66/ 2.8/ 3.06 GHz

Core Logic
• SIS M650 + 962 

Structure
• PC99 compliant

Security
• Security (Kensington® Type) Lock Slot
• BIOS Password
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Memory
• Two 200-pins DDR SODIMM sockets, support-

ing DDR SDRAM SODIMM (2.5V) - DDR 200/ 
DDR 266/ DDR 333 compliant

• Memory expandable up to 1024MB (128/256/
512MB SODIMM Modules)

BIOS
• One 512KB Flash ROM
• Phoenix BIOS

LCD Options
• 14.1" XGA TFT (1024*768)
• 15.0" XGA TFT (1024*768)
• 15.0" SXGA+ TFT (1400*1050)

Display
• High Performance 256-bit 3D engine

Advanced HW accelerator for DVD playback
Fully DirectX 8.0 compliant graphics engine

• Shared system memory (16/32/64MB DDR 
SDRAM)

• Dual-View display monitor

Audio
• AC'97 2.1 compliant interface 
• 3D stereo enhanced sound system
• Compatible with Sound-Blaster PRO™ 
• S/PDIF Digital output (5.1 CH) for DVD content 

and stereo audio
• Microphone-in jack
• Headphone-out jack
• Built-in microphone 
• 2 built-in speakers
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Storage Devices
• 3.5" 3-mode Floppy Disk Drive 

• Easy changeable 2.5" 9.5 mm (h) Hard Disk 
Drive 
Supports Master mode IDE
Supports PIO mode 4, ATA-33/66/100/133, Ultra 
DMA

• 12.7mm(h) Device Bay for ONE of the 
following drive configuration options:
CD-ROM
DVD-ROM
CD-RW
Combination CD-RW/DVD-ROM
DVD-RW

Keyboard
• “Win Key” keyboard

Pointing Device
• Built-in TouchPad (scrolling key functionality 

integrated) 

Interface
• Three USB 2.0/ 1.1 ports
• One Mini-IEEE 1394 port 
• One S-Video Out port for TV output
• One serial port
• One parallel port (LPT1), supporting ECP / EPP
• One infrared transceiver supporting IrDA 1.1/

FIR/SIR/ASKIR
• One external CRT monitor port
• One external keyboard/mouse (through Y cable) 

PS/2 port
• One speaker-out/headphone-out jack
• One microphone-in jack
• One RJ-11 jack for modem
• One RJ-45 jack for 100M/10M LAN
• One S/PDIF Out port
• One DC-in jack
• Wireless module On/Off switch
• Built-in 3 instant keys: WWW, email, and appli-

cation
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PC Card
• One Type II PCMCIA 3.3V/5V socket support-

ing CardBus

Communication
• Wireless Infrared transfer IrDA 1.1 compliant, 

1cm - 1M operating distance, 115.2K bps SIR/ 
4Mbps FIR

• 10/100Mb Ethernet LAN built-in
• 56K MDC modem V.90 & V.92 compliant
• 802.11b wireless LAN module (available as a 

factory option)
• Bluetooth module (available as a factory option)
• PC Camera module (available as a factory 

option)

Power Management
• Supports ACPI v1.0b
• Supports suspend to RAM (S3)
• Supports suspend to disk (S4)
• Supports Battery low suspend
• Supports resume from modem ring

Power
• Full range AC adapter

AC Input: 100~240V, 50~60Hz
DC Output: 20V, 6A

• Supports one removable Smart Li-Ion battery 

Indicators
• LED indicators (HDD, Power On/ AC-In/ Sus-

pend, Battery Charging/Battery Full, Num Lock, 
Caps Lock, Scroll Lock)

Environmental Spec
• Temperature

Operating: 5°C ~ 35°C
Non-Operating: -20°C ~ 60°C

• Relative Humidity
Operating: 20% ~ 80%
Non-Operating: 10% ~ 90%
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Physical Dimensions
• 329 (w) x 275 (d) x 36.5 (h) mm

Weight
• Around 2.8 kg (depend on optional modules 

included) without battery 

Optional
• DVD-ROM Drive
• CD-RW Drive
• Combination Drive
• Software DVD player
• Wireless LAN module
• Bluetooth module
• PC Camera module
• DVD-RW Drive
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